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  Editorial


  
    Welcome to the latest issue of Full Circle


    This month, we give you the Full Monty: Python, Stable Diffusion, Latex, Micro This Micro That, Inkscape, and the thrilling conclusion to the short series on trying Linux.


    Elsewhere we have reviews of Pop!_OS 22.04 LTS, Ubuntu Budgie 23.04, another Python book review from Greg and a review, by Erik, of the game Moonstone Island.


    I'm sure, by now, many of you will have already upgraded to 23.10 in some flavor. Next month brings Adam's first review of the 23.10 series with, of course, Ubuntu. Have you upgraded yet? Which flavor are you using? You didn't upgrade? Why not? I'd love to hear your thoughts. Whether it be the good, the bad or the ugly.


    Don't forget: we have a Table of Contents which lists every article from every issue of FCM. Huge thanks to Paul Romano for maintaining: https://goo.gl/tpOKqm and, if you're looking for some help, advice, or just a chinwag: remember that we have a Telegram group: https://t.me/joinchat/24ec1oMFO1ZjZDc0. I hope to see you there. Come and say hello.


    All the best! Ronnie ronnie@fullcirclemagazine.org
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    FCM PATREON : https://www.patreon.com/fullcirclemagazine
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  NEWS


  Submitted by ErikTheUnread


  
    Full Circle Weekly News
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    The show is also available via:


    
      	RSS: http://fullcirclemagazine.org/feed/podcast


      	Stitcher Radio: http://www.stitcher.com/s?fid=85347&refid=stpr


      	TuneIn Radio: http://tunein.com/radio/Full-Circle-Weekly-News-p855064/


      	PlayerFM: https://player.fm/series/the-full-circle-weekly-news

    


    Enjoy! Ronnie

  


  


  Week 39


  Wolvic 1.5 light:


  25/09/2023


  Wolvic 1.5, intended for use in augmented and virtual reality systems, is out. The project continues to develop the Firefox Reality browser, which was previously developed by Mozilla. After the stagnation of the Firefox Reality code base as part of the Wolvic project, it was continued by Igalia, known for its participation in the development of free projects such as GNOME, GTK, WebKitGTK, Epiphany, GStreamer, Wine, Mesa and freedesktop.org. The Wolvic code is written in Java and C++, and is distributed under the MPLv2 license. Ready-made builds are available for the Android platform. 3D helmets like Oculus, Huawei VR Glass, Lenovo VRX, Lenovo A3, HTC Vive Focus, Pico Neo, Pico4, Pico4, Meta Quest Pro and Lynx are supported. (also portable the browser for Qualcomm devices).


  They’ve made a number of user interface (UI) improvements, such as the new hand models we show on all hand-tracking devices. These look a fair bit like actual hands, which is useful when trying to manipulate virtual objects.


  The second major UI improvement is the Find in Page feature, which works like it does in 2D browsers: you input a bit of text and Wolvic will highlight all occurrences of it in the page. You use arrow buttons to jump from one occurrence to the next (or to the previous) which can be very useful for finding specific bits of text in long pages like Wikipedia articles.


  Third but by no means last, they’ve added a brand new date and time pickers, which are designed to be easily usable in virtual environments.


  https://wolvic.com/blog/release_1.5/


  KaOS 2023.09:


  26/09/2023


  KaOS 2023.09, a distribution with a continuous update model aimed at providing a desktop based on the latest releases of KDE and applications using Qt, is out. From the features specific to the design, you can note the placement of a vertical panel on the right side of the screen. The distribution is evolving with an eye on Arch Linux, but supports its own independent repository, with over 1,500 packages and offers a number of its own graphical utilities. XFS is used as a default file system. Builds are published for x86_64 (3.5 GB). Separately, iso-images are built for testing components developed in the experimental branch of KDE Plasma 6. In November, they plan to release the last update of KaOS based on KDE Plasma 5 and switch to KDE Plasma 6.


  https://kaosx.us/news/2023/kaos09/


  LibrePCB reaches 1.0:


  26/09/2023


  The release of LibrePCB 1.0.0, which is the first full-fledged release, free from restrictions that prevent the creation of sufficiently complex PCBs, was announced. LibrePCB is positioned as an intuitive package for the rapid development of boards, which lags behind in functionality from KiCad, but much easier use and at the same time takes into account the needs of not only beginners, but also professional engineers. The program is available in builds for Linux (Flatpak, Snap, AppImage), FreeBSD, macOS and Windows. The project code is written in C++ (Qt interface) and is distributed under the GPLv3 license.


  LibrePCB includes a project management interface, an electronic circuit editor, a multi-layer printed circuit board editor, a service for generating data to start production, a librepcb-cli command line utility to automate typical work (e.g., validation and export of data), an electronic component library with navigation on a tree categorized list, an interface for connecting various existing libraries of elements that can be added both in the form of archives and integration. It supports the import of DXF files and export in PDF, SVG and CSV BOM, pick&cap X3/CSV, Gerber/Excellon and STEP formats.


  https://librepcb.org/blog/2023-09-24_release_1.0.0/


  GNU Project is 40 years old:


  27/09/2023


  On September 27, 1983, Richard Stallman founded the GNU (Gnu's Not Unix) project, aimed at developing system components to create a free Unix analogue that can completely do without proprietary software. GNU forms a community of free projects moving towards a common goal and are developed according to a single ideology and philosophy.


  Currently, 385 free projects are developing under the GNU flag, including GCC, Glibc, Bash, Emacs, Emacs, binutils, classpath, coreutils, syutils, ddd, freeFont, gakk, GDB, GetText, Ghostscript, GSMP, Gnash, Gnumeric,curses, screen and wget.


  Initially, the central links of the project were the GNU core, developer tools and a set of applications and utilities for the user environment, including a text editor, a board processor, a command shell and even a set of games. The core developed by the project was not properly distributed, but the user environment and development tools were in demand and, in combination with the Linux kernel, which formed the basis of GNU/Linux distributions.


  https://www.gnu.org/gnu/initial-announcement.html


  Release of Porteus 5.01:


  27/09/2023


  More than a year after the last update was published, there is Porteus 5.01 Live distribution, built on the Slackware Linux package base and offers builds with Xfce, Cinnamon, GNOME, KDE, LXDE, LXQt, MATE and OpenBox. The composition of the distribution is selected for the minimum consumption of resources, which allows you to use Porteus on outdated equipment. Features include a high loading speed. To download, compact Live images are offered, about 380 MB in size, built for the i586 and x86_64 architectures.


  The new version is synchronized with the repository of Slackware 15.0-patches, the Linux kernel has been updated to version 6.5. New versions of Sysvinit 3.07, BusyBox 1.36.1, mpv 0.36.0, VirtualBox 7.01, proprietary drivers NVIDIA 535 and 470 are offered. Perl is moved to the 05-devel module, and the xcb stack to 002-xorg. They added the convertz script to convert the directory with xz compressed modules, to modules compressed using the zstd algorithm. They also added a new version of the user environment LXQt.


  https://forum.porteus.org/viewtopic.php?t=11004&p=95911


  Linux Mint Debian Edition 6:


  27/09/2023


  A year and a half since the last release, the release of an alternative build of Linux Mint - Linux Mint Debian Edition 6 distribution, built on Debian (the classic Linux Mint is based on the Ubuntu package base) has been released. The distribution is available as installation iso-images with Cinnamon 5.8 desktop environment.


  LMDE is focused on technically literate users and provides newer versions of packages. The goal of LMDE is to verify that Linux Mint will be able to continue to exist in the same form even if Ubuntu is discontinued. In addition, LMDE helps to check project-developed applications for their full operation in systems other than Ubuntu.


  The delivery of LMDE includes most improvements in the classic Linux Mint 21.2 release, as well as original project development (application manager, update system, configurators, menus, Xed text editor, photo manager Pix, Xreader document viewer, Xreader image viewer). The distribution is fully compatible with Debian GNU/Linux 12, but is not compatible at the package level with Ubuntu and classic Linux Mint releases. The system environment corresponds to that of Debian GNU/Linux 12 (Linux 6.1, systemd 252, GCC 12.2, Mesa 22.3.6).


  https://blog.linuxmint.com/?p=4570


  Release of CrossOver 23.5:


  28/09/2023


  CodeWeavers has released the Crossover 23.5 package, based on the Wine code and designed to run programs and games written for the Windows platform. CodeWeavers is one of the key participants of the Wine project, sponsors its development and returns to the project all the innovations implemented for its commercial products.


  The new version, which continues to be based on Wine 8.0.1, vkd3d 1.8 and DXVK 1.10.3, improved compatibility with Debian 13 (Debian Testing), open SUSE 15.1 and Ubuntu 23.10. The builds for the macOS platform have 14 "Sonoma" compatibility, support for GStreamer and the broadcasting layer from the Game Porting Toolkit is provided, the configuration has been added to use D3DMetal instead of DXVK, problems are solved when running games protected by Denuvo, added support for the game Baldur's Gate 3, improved quality and improved performance in other games like Mortal Kombat 1, Deep Rock Galactic, Satisfactory, Monster Hunter Rise, God of War and Batman Arkham Knight.


  https://www.codeweavers.com/support/forums/announce/?t=24;msg=289484


  Red Hat moves from Bugzilla Error Tracking System to JIRA:


  29/09/2023


  Red Hat has announced the redeployment of Red Hat Enterprise Linux and CentOS Stream to a new error tracking system.redhat.com, built on the Jira proprietary platform developed by Atlassian. Earlier, Red Hat used its own edition of the free error tracking platform Bugzilla. The Fedora project will continue to use Bugzilla, despite the introduction of Jira in RHEL and CentOS Stream. The reason for migration is the desire to consolidate the management of all projects in one place and use Jira as a single platform for managing all aspects of development. It is also noted that the use of Jira will expand the opportunities for collaboration and increase the flexibility in providing access to partners and the community to different stages of development. Jira's advantages are advanced visualization capabilities, intuitive hierarchy management and the presence of REST API.


  https://www.redhat.com/en/blog/rhel-tracking-moving-to-jira


  COSMIC's replacement of windows:


  29/09/2023


  System76, who are developing the Pop!_OS Linux distribution, published a September report on the development of a new edition of the COSMIC user environment, rewritten in the Rust language (not to be confused with the old COSMIC, which was based on GNOME Shell). The environment develops as a universal project, not tied to a specific distribution and conforming to the specifications of Freedesktop. The project is also developing a composite server cosmic-comp based on Wayland.


  Recent changes have seen the implementation of the Window-Swappin mode to replace windows when using mosaic (tile) layout. Thanks to the Auto-tiling function, the position for new windows on the screen is selected automatically, which might not always match the expectation of the user. (The window can be moved manually, but this requires additional manipulation and distracts the user.) To simplify the overshuffle operation of windows, a quick replacement mode is proposed, allowing you to press and hold the keyboard combination "Super + X" (Windows + X) quickly move the window by additionally pressing the cursor control keys.


  https://blog.system76.com/post/cosmic-september-new-window-swapping-mode


  Ubuntu Snap Store identified malicious packages:


  30/09/2023


  Canonical announced a temporary suspension of the use in the Snap Store for automatic system checking of published packages, due to the appearance in the repository of packages with malicious code for the theft of cryptocurrency from users. At the same time, it is unclear whether the incident is limited by the publication of malicious packages by third-party authors or there are any security problems directly in the repository, since the situation in the official announcement is characterized as a "potential security incident."


  Details about the incident are promised to be disclosed after the inspection. At the time of the inspection, the service is transferred to manual review mode, in which all registrations of new snap-packs will be manually checked before publication. The change will not affect the download and publication of updates for existing snap packages.


  Problems were identified in the packages ledgerlive, ledger1ledger1, trezor-wallet and electrum-wallet2electrum-wallet2, published by attackers under the guise of official packages from the developers of the noted crypto wallets, but in fact had nothing to do with them. Currently, problematic snaps have already been removed from the repository and are no longer available.


  https://forum.snapcraft.io/t/temporary-suspension-of-automatic-snap-registration-following-security-incident/37077


  New release of auto-cpufreq 2.0:


  30/09/2023


  After four years of development, the release of the auto-cpufreq 2.0 utility, designed to automatically optimize the speed of the CPU and power consumption in the system, is presented. The utility monitors the state of the laptop battery, the load on the CPU, the temperature of the CPU and the activity in the system, and depending on the situation and the selected options, dynamically activates energy saving modes or high performance. It is supported on devices with Intel, AMD and ARM processors. The code is written in Python and distributed under the LGPLv3 license.


  Auto-cpufreq can be used to automatically extend the battery life of laptops without constantly cutting any features. Unlike the TLP utility, the auto-cpufreq not only allows you to set economical power modes during the offline operation of the device, but also temporarily turn on high performance mode(turbo boost) when identifying an increase in the load on the system.


  https://github.com/AdnanHodzic/auto-cpufreq/


  Week 40


  A VeraCrypt 1.26:


  02/10/2023


  After a year and a half of development, a release of the VeraCrypt 1.26 project was published, developing a fork of the TrueCrypt disk encryption system, which was discontinued. VeraCrypt is notable for the replacement of the RIPEMD-160 algorithm used in TrueCry with SHA-512 and SHA-256, an increase in the number of hashaching iterations, simplification of the build process for Linux and macOS, the elimination of problems identified in the TrueCrypt source. VeraCrypt 1.25.9's previous official release was released in February 2022. Developed by the VeraCrypt project, the code is distributed under the Apache 2.0 license, and borrowing from TrueCrypt continue to be supplied under the TrueCrypt License 3.0. Ready-made builds are available for Linux, FreeBSD, Windows and macOS.


  https://www.veracrypt.fr/en/Release%20Notes.html


  Budgie 10.8.1:


  02/10/2023


  Buddies Of Budgie has published an update to the desktop environment Budgie 10.8.1. The user environment form the separate components supplied with the implementation of the Budgie Desktop, a set of Budgie Desktop icond, a Budgie Desktop View interface, an interface for configuring the Budgie Control Center (GNOME Control Center) and the screen keeper Budgie Screensaver (gnome-screensaver fork). The project code is distributed under the GPLv2 license. You can use distributions such as Ubuntu Budgie, Fedora Budgie, Solus, GeckoLinux and EndeavourOS to familiarize yourself with Budgie.


  To manage windows, Budgie uses Budgie Window Manager (BWM), which is an extended modification of the Mutter plugin. All elements of the panel are applets, which allows you to flexibly adjust the composition, change the placement and replace the implementation of the main elements of the panel to your taste. Among the available applets you can note the classic application menu, the task switching system, the area with an open window list, virtual desktop viewing, power control indicator, volume control, system status indicator and clock.


  https://buddiesofbudgie.org/blog/budgie-10-8-1-released


  Advertising ransomware as Thunderbird mail client:


  03/10/2023


  The developers of the Thunderbird project warned users about the appearance of ads offering to install ready-made collections of the Thunderbird mail client in the Google advertising network. In fact, under the guise of Thunderbird, malware was distributed, which after installation collected and sent confidential and personal information from user systems to an external server, after which the attackers extorted money not to disclose the information (for example, non-disclosure corporate data). In addition to Thunderbird there were advertising of similar malicious builds of Discord, Microsoft Teams and Adobe Reader.


  Users are advised to use only official sources of Thunderbird, such as thunderbird.net, packages from regular Linux distribution repositories and official project pages in the Microsoft Store, Snap Store and Flathub directories.


  https://blog.thunderbird.net/2023/10/ransomware-alert-are-you-using-a-trusted-version-of-thunderbird/


  Mint Edge 21.2 with new Linux kernel:


  03/10/2023


  The developers of the Linux Mint distribution announced the publication of a new iso-image "Edge," which is based on the July release of Linux Mint 21.2 with the Cinnamon DE and differs in having the Linux 6.2 kernel instead of 5.15. In addition, they support the UEFI SecureBoot mode.


  The build is aimed at users of new hardware, who have problems with the installation and download of Linux Mint 21.2 when using the Linux 5.15 kernel, which was formed in the fall of 2021 and used as a base core in Ubuntu 22.04 LTS. The package with the 6.2 kernel is moved to Linux Mint 21.2 from Ubuntu 22.04.3, which it was backedported from the release of Ubuntu 23.04.


  https://blog.linuxmint.com/?p=4584


  Release of Elementary OS 7.1:


  04/10/2023


  The release of the Elementary OS 7.1 distribution, positioned as a fast, open and respectful alternative to Windows and macOS, is out. The project focuses on high-quality design aimed at creating an easy-to-use system that consumes minimal resources and provides high-speed launch. Users are offered their own Pantheon desktop environment. Iso-images (3 GB), available for the amd64 architecture id up.


  The graphical environment is based on Pantheon's own shell, which brings together components such as the Gala window manager (based on LibMutter), the WingPanel top panel, the Slingshot lighthouse, the Switchboard control panel, the bottom of the Plank task panel (rewritten to Vala an analogue of the Docky panel) and the Pantheon Greeter session manager (based on LightDM).


  The environment includes a set of closely integrated applications in a single environment. Among these applications, most of them the project's own development, were the Pantheon Terminal emulator, Pantheon Files file manager, Code text editor, and Music music player (Noise) The project also develops photo manager Pantheon Photos (response from Shotwell) and Mail mail client (inhabitation from Evolution).


  https://blog.elementary.io/os-7-1-available-now/


  Release of OpenSSH 9.5:


  05/10/2023


  The release of OpenSSH 9.5, open implementation of the client and server for SSH 2.0 and SFTP protocols has been published. Main changes are to the ssh-keygen. By default includes the generation of keys based on the Ed25519 digital signature, developed by Daniel Bernstein and standardized in RFC 8709. It is noted that the Ed25519 keys are supported starting from the 2014 release of OpenSSH 6.5 and more convenient because of its small size. At the same time, the digital signatures of Ed25519 have a higher level of security than ECDSA and DSA, and show a very high speed of verification and signature creation. The cracking resistance for Ed25519 is about 2x128 (on average, the attack on Ed25519 will require 2x140 bit operations), which corresponds to the resistance of algorithms such as NIST P-256 and RSA with a key size of 375 bytes or 128-bit block ciphers. Ed25519 is also not subject to problems with hashes, not sensitive to attacks by determining cache-timing attacks and screen attacks on third-channel attacks.


  https://lists.mindrot.org/pipermail/openssh-unix-dev/2023-October/040967.html


  Slax 15.0.3 and 12.1.0:


  05/10/2023


  New versions of the compact Live distribution Slax - 15.0.2 based on the development of the Slackware project and 12.1.0 based on Debian (in 2018, the distribution was transferred to the Debian package base, but in the release of Slax 15 the project returned back to the use of Slackware). The graphical environment in Slax is built with the FluxBox window manager and the desktop/interface to run xLunch programs, specially developed by the project participants. The image of version 15.0.3 takes 470 MB (x86_64, i386), and version 12.1.0 - 435 MB (x86_64, i386).


  https://www.slax.org/blog/27935-New-Slax-Key-Features-and-Enhancements.html


  Valve has released Proton 8.0-4:


  05/10/2023


  Valve has published an update to the Proton 8.0-4 project, based on the Wine project and aimed at providing launching of gaming applications created for Windows and presented in the Steam catalog. The project is distributed under the BSD license.


  Proton allows you to directly run (in the Steam Linux client) gaming applications supplied for Windows only. The package includes the implementation of DirectX 9/10/11 (based on the DXVK package) and DirectX 12 (based on vkd3d-proton), running through the broadcast of DirectX calls in the Vulkan API, provides improved support for game controllers and the ability to use the full-screen mode regardless of the screen resolutions supported in games. The "esync" (Eventfd Synchronization) and "futex/fsync" and "futex/fsync" mechanisms are supported to increase the performance of multithreaded games.


  https://github.com/ValveSoftware/Proton/releases/tag/proton-8.0-4


  Opening the code of Ferrocene:


  06/10/2023


  Ferrous Systems has announced the launch of the Ferrocene, a proprietary distribution with the Rust compiler for critical systems, into an open project. The Ferrocene code is published under the Apache 2.0 and MIT licenses. Ferrocene provides a toolkit for developing Rust language applications for information protection and critical systems requiring increased reliability (Safety-Critical Systems), which can jeopardize people's lives, harm the environment or cause serious damage to the equipment.


  As the basis of the 'rustc', a staff compiler from the Rust project, is used to meet the requirements of software environments for automotive and industrial systems (ISO 26262 and IEC 61508).


  https://ferrous-systems.com/blog/ferrocene-open-source/


  Release of jsii 1.90:


  07/10/2023


  Amazon has published a compiler jsii 1.90, which is a modification of the TypeScript compiler, which allows you to extract information about the API from the compiled modules and generate a universal representation of this API to access JavaScript classes from applications in different programming languages. The project code is written in TypeScript and distributed under the Apache 2.0 license.


  Jsii makes it possible to create (in TypeScript) a library of classes that can be used in projects in C, Go, Java and Python, thanks to the translation of modules that provide the same API. The toolkit is used in the AWS Cloud Development Kit to supply libraries for different programming languages generated from a single code base. The new version implements caching the list of classes for each build and has documented how you can turn a mandatory property into an optional one.


  https://github.com/aws/jsii/releases/tag/v1.90.0


  Presenting OpenPubKey:


  08/10/2023


  The Linux Foundation, BastionZero and Docker have unveiled an open project, OpenPubKey, which develops the eponymous cryptographic protocol for certification of arbitrary objects. The technology was developed as a joint project of BastionZero and Docker to simplify the certification of digital signatures of Docker container images, to exclude their substitutions and to confirm the build of the declared creator. The project will develop on a neutral platform under the auspices of the Linux Foundation, which will eliminate dependence on individual commercial companies and simplify joint work with third-party participants. The OpenPubKey's reference is written in Go and is distributed under the Apache 2.0 license.


  The capabilities of OpenPubKey are not limited to container imagery and the technology can be used to confirm the source of any resource, prevent dependencies substitution and improve the security of data sets and distribution channels. For example, the technology is applicable to certify program builds, individual messages and commits. The signature creators have sufficiently vowed to have an account in the service that supports OpenID, and consumers are given the opportunity to check the attached signatures and confirm their connection with the declared OpenID identifier.


  https://www.linuxfoundation.org/press/announcing-openpubkey-project


  First release of Incus:


  08/10/2023


  The first release of the Incus project is presented, where the Linux Containers community develops a fork of the LXD container management system, created by the old team of developers that once created LXD. The Incus code is written in Go and is distributed under the Apache 2.0 license.


  The Linux Containers community oversaw the development of LXD before Canonical decided to develop LXD alone as a corporate project. The goal of the fork is to provide an alternative to the LXD project, controlled by the company LXD. As part of the Incus project, they also plan to eliminate some conceptual errors made during the development of LXD, which previously could not be corrected without breaking backward compatibility.


  In terms of functionality, the first release of Incus, corresponds to the recently released LXD 5.18 update and focuses primarily on the renaming and reorganization of the codebase, as well as the removal of outdated capabilities. At the same time, the new version also notes the changes specific to Incus in the command line interface and API, which were not included in LXD due to the requirements for backward compatibility. In the future, the developers plan to transfer useful improvements and fixes from the LXD code base, but also developing their original innovations, which, if desired, Canonical will be able to port to LXD.


  https://groups.google.com/a/lists.linuxcontainers.org/g/lxc-users/c/5G6jN--29uU


  Week 41


  Free sound editor Ardour 8.0:


  10/10/2023


  A new release of the free sound editor, Ardour, designed for multi-channel recording, processing and mixing of sound, has been published. Ardour provides a multi-track timeline, an unlimited level of rolling back changes throughout the file (even after the program is closed) and support for a variety of hardware interfaces. The program is positioned as a free analogue of professional tools, like ProTools, Nuendo, Pyramix and Sequoia. The code is distributed under the GPLv2 license. In the near future, ready-made builds for Linux will be available in Flatpak format.


  https://ardour.org/whatsnew.html


  Ubuntu will restrict access to user namespace:


  10/10/2023


  Canonical has announced changes in Ubuntu 23.10 that restrict the access of unprivileged users to user namespace that will increase the security of systems using container isolation from vulnerabilities that require the operation of user namespace. According to Google, 44% of exploits participating in the money rewards program for identifying vulnerabilities in the Linux kernel require the possibility of creating user Identifiers.


  Instead of blocking access to the user namespace in Ubuntu, a hybrid scheme selectively allowing some programs the ability to create a user namespace if the AppArmor profile is with the rule "allow userns create" or CAP_SYS_ADMIN rights.


  In the upcoming release of Ubuntu 23.10, the restriction of access to user namespace is planned to not be included by default. Within a few weeks of the release of Ubuntu 23.10, the developers will collect information about the possible negative impact of disabling access to the user namespace, relating to packages and prepare the appropriate AppArmor profiles. Then, in one of the corrective updates, the limit will be activated by default.


  https://canonical.com//blog/ubuntu-23-10-restricted-unprivileged-user-namespaces


  Wayfire 0.8, using Wayland:


  10/10/2023


  After almost three years of development, the release of the Wayfire 0.8 composite server, using Wayland, allowing one to create resource-demanding user interfaces with 3D plug-in-style solutions, like Compiz (switching screens via 3D, spatial layout of windows, morphing when working with windows, etc.). Wayfire supports the extension through plugins and provides a flexible customization system. The project code is written in C++ and distributed under the MIT license.


  The project is based on the wlroots library, in turn developed by the developers of Sway and providing basic functions for the composite manager based on Wayland. Systemd, elogind or seatdd can be used to manage sessions. It supports the launch of X11 applications using XWayland. As a panel you can use wf-shell from Wayfire developers or outside the LavaLauncher panel. The project is also working on a library for working with wf-config files and a wcm graphic configurator.


  https://wayfire.org/2023/10/07/Wayfire-0-8.html


  Fedora project's laptop:


  11/10/2023


  The Fedora project presented their ultrabook, the Fedora Slimbook, prepared in conjunction with the Spanish equipment supplier Slimbook. The device is optimized for the Fedora Linux distribution and is specifically tested to achieve a high level of environment stability and software compatibility with equipment. The initial cost of the device is declared in 1799 euros, with 3% of the proceeds from the sale of devices planned to be directed as a donation to the GNOME Foundation.


  https://fedoramagazine.org/fedora-slimbook-available-now/


  Release of Krita 5.2"


  11/10/2023


  After more than a year of development, the release of the raster graphic editor Krita 5.2.0, designed for artists and illustrators, is out. The editor supports multi-layer image processing, provides tools to work with different color models and has a large set of tools for digital painting, sketches and texture formation. AppImages for Linux, experimental APK packages for ChromeOS and Android, as well as binary builds for macOS and Windows have been prepared for installation. The project is written in C++ using the Qt library and distributed under the GPLv3 license


  https://vpnoverview.com/news/mastercard-must-stop-selling-transaction-data-groups-demand/


  Release of Raspberry Pi OS:


  12/10/2023


  The developers of the Raspberry Pi project have published a new major release of Raspbian (Raspberry Pi OS 2023-10-10), based on Debian. To download, three builds are prepared - minimal (435 MB) for server systems, with a base desktop (1 GB) and a full set of applications (2.7 GB). About 35 thousand packages are available for installation from the repositories.


  https://www.raspberrypi.com/news/bookworm-the-new-version-of-raspberry-pi-os/


  Release of Ubuntu 23.10:


  12/10/2023


  Ubuntu 23.10 "Mantic Minotaur" distribution has been released, which is attributed to an intermediate release, with updates only for 9 months (support will be carried out until July 2024). Ready-made installation images are made for Ubuntu, Ubuntu Server, Lubuntu, Kubuntu, Ubuntu Mate, Ubuntu Budgie, Ubuntu Studio, Xubuntu, UbuntuKylin (edition for China), Ubuntu Unity, Edubuntu and Ubuntu Cinnamon.


  https://canonical.com/blog/canonical-releases-ubuntu-23-10-mantic-minotaur


  OpenSUSE Leap Micro 5.5:


  13/10/2023


  The developers of the openSUSE project published an atomically updated openSUSE Leap Micro 5.5 distribution, designed to create microservices and used as a basic system for virtualization and container insulation platforms. To download, builds for the architectures x86_64 and ARM64 (Aarch64) are available, supplied both with the installer and in the form of a ready-made boot image: 782 MB (preconfigured), 959 MB (with Real-Time core) and 1.1 GB. Images can be run under the control of Xen and KVM hypervisors or on top of ARM equipment, including Raspberry Pi boards.


  The openSUSE Leap Micro distribution is based on the MicroOS project and is positioned as a community version of the SUSE Linux Enterprise Micro commercial product, which differs in the lack of a graphical interface. To configure it, you can use the Cockpit web-interface, which allows you to control the system through the browser and cloud-init tools with the transfer of settings at each download. The user is provided with a toolkit for quick switching from Leap Micro to SUSE SLE Micro - it is implied that you can first implement a solution based on Leap Micro for free, and if necessary, advanced support or certification, transfer the already existing configuration to SUSE SLE Micro.


  https://news.opensuse.org/2023/10/12/leap-micro-55-hands-on/


  NGINX toolkit for the development of modules in Rust:


  13/10/2023


  NGINX project developers presented ngx-rust tools, that allows you to create modules for the http server and multiprotocol NGINX proxies in the Rust programming language. The ngx-rust code is distributed under the Apache 2.0 license and is still in beta.


  Initially, the toolkit was developed as a project for forcing the development of the Istio-compatible Service mesh for the Kubernetes platform, working on top of NGINX. The product did not go beyond the prototype and was stagnating for several years, but examples of bindings published in the process of creating a prototype were used by the community in third-party projects to expand the capabilities of NGINX in Rust.


  https://www.nginx.com/blog/extending-nginx-with-rust-an-alternative-to-c/


  Linux 6.1 core will last 10 years:


  13/10/2023


  The Linux Foundation announced the provision of a long support cycle for the Linux 6.1 core. Support will be provided within the framework of the SLTS (Super Long Term Support) program, which, unlike LTS (Long Term Support), involves focussing on the use of the core in civilian infrastructure and in important industrial systems. Updates for the Linux 6.1 branch will be released for at least 10 years, during which not only patches affecting reliability and security will be transferred to the core, but also ported from newer branches, to support new equipment. Previously, such an extended tracking cycle was applied to kernels 4.4, 4.19 and 5.10.


  The SLTS branch will be supported by the Civil Infrastructure Platform (CIP), which has partnered with companies such as Toshiba, Siemens, Renesas, Bosch, Hitachi and MOX, under the auspices of the Linux Foundation. In addition to representatives of the above-mentioned companies, the maintainers of the LTS core of the main core, Debian developers and the creators of the KernelCI project will be involved in the support of the SLTS core.


  https://www.linuxfoundation.org/press/civil-infrastructure-platform-expands-slt-stable-kernel-program


  Chrome 118 and Chromium.


  14/10/2023


  Google has released Chrome 118 with third party cookie protections. At the same time, a stable release of the free Chromium project, which is based on Chrome, is available. The Chrome browser differs from Chromium by removing Google logos, the presence of a notification system in case of collapse, modules for playing video content protected from copying (DRM), automatic update system, constant on Sandbox insulation, delivery of keys to Google API and transmission when searching for RLZ-parameters. For those who need more time to upgrade, the Extended Stable branch is separately supported, followed by 8 weeks. The next Chrome 119 is scheduled for October 31 with more ways to force ads down your throat.


  https://chromereleases.googleblog.com/2023/10/stable-channel-update-for-desktop_10.html


  Release of Electron 27.0:


  15/10/2023


  The Electron 27.0.0 platform has been released, which provides a self-sufficient framework for the development of multi-platform user applications, which uses Chromium, V8 and Node.js components as a base. A significant change in the version number is due to the update to the Chromium 118 codebase, the Node.js 18.17.1 platform and the V8 11.8 JavaScript engine.


  https://www.electronjs.org/blog/electron-27-0
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  Release of the OpenSilver 2.0 platform:


  16/10/2023


  The OpenSilver 2.0 project, which continues the development of the Silverlight platform and allows you to create interactive web-applications using C, XAML and .NET has a new release. Silverlight applications compiled with OpenSilverver can work in any desktop and mobile browsers with WebAssembly support, but the compilation is still possible only in Windows using the Visual Studio environment. The project code is written in the C language and distributed under the MIT license.


  In its current form, OpenSilver has already gone beyond the Silverlight life extension layer and can be considered as an independent platform for creating new applications. For example, the project is developing an addition to Visual Studio, support for new versions of the C language and the .NET platform and compatibility with libraries in JavaScript.


  https://opensilver.net/announcements/2-0/


  OpenBSD 7.4:


  16/10/2023


  A release of a free UNIX-like operating system OpenBSD 7.4 is presented. The OpenBSD project was founded by Theo de Raadt in 1995 after a conflict with NetBSD developers, which resulted in the closure of Teo's NetBSD repository. After that, Tao de Raadt and a group of like-minded people created a new open operating system based on the NetBSD source tree, the main goals of which were portability (supported by 13 hardware platforms), standardization, correct operation, proactive security and integrated cryptographic tools. The size of the full installation ISO image of the base system OpenBSD 7.4 is 630 MB.


  In addition to the operating system, the OpenBSD project is known for its components, which have been distributed in other systems and have proven themselves as one of the most secure and high-quality solutions. Among them are: LibreSSL (OpenSSL fork), OpenSSH, packet filter PF, pharmacological routing demons OpenBGPD and OpenOSPFD, NTP server OpenNTPD, mail server OpenSMTPD, multiplexer of the text terminal (similar to GNU screen) tmux, identd daemon with implementation of the IDENT protocol, BSDL-alternator package for the organization's easily , the object of the Red-creator.OpenRSYNC file synchronization utility.


  https://www.mail-archive.com/announce@openbsd.org/msg00498.html


  Release of VirtualBox 7.0.12:


  17/10/2023


  Oracle has released the virtualization system VirtualBox 7.0.12, which noted 24 patches. At the same time, an update of the last branch of VirtualBox 6.1.48 with 9 changes was formed, including support for the Linux 6.5 and 6.6-rc kernels, support for OpenSUSE 15.5, improved support for the Linux 6.4 kernel and patches for the kernel from RHEL 8.9 and 9.3.


  https://www.mail-archive.com/vbox-announce@virtualbox.org/msg00227.html


  New CEO of GNOME Foundation:


  18/10/2023


  The GNOME Foundation, which oversees the development of the GNOME user environment, has announced the appointment of Holly Million as CEO, which has remained vacant since August last year after Neil McGovern's departure. The Executive Director is responsible for the management and development of the GNOME Foundation as an organization, as well as for interaction with the Board of Directors, the Advisory Board (Advisory Board) and members of the organization.


  Holly Million has extensive experience in managing non-profit organizations and is a versatile person who has manifested herself as a producer of documentaries, writer, shaman, phytotherapist, artist and educator. Holly went from a non-profit consultant to a development director, a member of the board of directors of various organizations, executive director of the BioBricks Foundation, developing open projects in the field of biotechnology, and the founder of Artists United, which brings together artists and connoisseurs of art, and promoting the idea that many social problems can be solved through learning to understand art. (make of that what you will)


  https://foundation.gnome.org/2023/10/17/foundation-welcomes-new-executive-director/


  Release of MediaGoblin 0.13:


  18/10/2023


  A new version of the decentralized platform for the exchange of media files, MediaGoblin 0.13.0, designed for hosting and exchanging media content, including photos, videos, sound files, three-dimensional models and PDF documents, has been published. Unlike centralized services like Flickr, YouTube and SoundCloud, MediaGoblin is aimed at organizing content, sharing without being linked to a particular service and using a model similar to StatusNet and pump.io, which allows you to run the server at your own facilities. The project code is written in Python and distributed under the AGPLv3 license.


  https://mediagoblin.org/news/mediagoblin-0.13.0-release.html


  For Kubuntu 22.04 packages with KDE Plasma 5.27:


  19/10/2023


  The developers of the Kubuntu distribution announced the possibility of switching to a fresh stable version of KDE in the LTS-version of the Kubuntu distribution 22.04. Packages with KDE Plasma 5.27, KDE Frameworks 5.110 and KDE Gear 23.08 are offered for installation, which are backedported from Kubuntu 23.10. In the regular version of Kubuntu 22.04 LTS they only offered releases of KDE Plasma 5.24 and KDE Gear 21.12.


  https://kubuntu.org/news/plasma-5-27-lts-for-jammy-22-04-lts-available-via-ppa


  Intel has released OSPRay 3.0 engine:


  19/10/2023


  Intel has published a scalable 3D rendering engine OSPRay 3.0, designed for realistic high-quality visualization by ray tracing. The engine is developing as part of a larger Intel Rendering Framework project aimed at developing software visualization tools for SDV's (Software Defined Visualization), including the Embree ray tracing library, GLuRay photorealistic drawing system, the library to eliminate noise on an image, oidn (Open Image Denoise) and the OpenSWR software rasterization. The code is written in C++ and published under the Apache 2.0 license.


  OSPRay can operate without being tied to the GPU, which allows you to use the library on a wide range of devices, from workstations to nodes in computing clusters. Multithreading and vectoring based on SIMD instructions, such as Intel SSE4, AVX2, AVX2, and AVX-512, are actively used to provide proper performance (OSPRay at least SSE4.1) support is required for OSPRay.


  https://github.com/ospray/ospray/releases/tag/v3.0.0


  Release of Asterisk 21:


  20/10/2023


  After a year of development, a new stable branch of the open communication platform Asterisk 21, used to deploy software PBXs, voice communication systems, VoIP gateways, IVR-motor organization (voice menu), voice mail, telephone conferences and call centers, is out. The source code of the project is available under the GPLv2 license.


  Asterisk 21 is classified as regular support release, with updates for the next two years. Support for the Asterisk 20 LTS will last until October 2027, and Asterisk 18 until October 2025. Support for LTS 17.x discontinued. In the preparation of LTS-releases, the focus is on ensuring stability and optimizing performance, the priority of conventional releases is to increase functionality.


  https://www.asterisk.org/asterisk-news/asterisk-21-0-0-now-available/


  Integrated development environment Geany 2.0 is available:


  20/10/2023


  It's the 18th birthday of Geany! On October 19, 2005 Geany 0.1 was released. While this first version had less features than the new version, the spirit and project goals were the same and kept over time.


  The release of the Geany 2.0 project, which develops a compact and fast code editing environment, using a minimum number of dependencies and is not tied to the features of individual user environments, such as KDE or GNOME, is out. Geany requires only the GTK library and its dependencies (Pango, Glib and ATK). The project code is distributed under the GPLv2+ license and written in the C and C++ languages (in C++, the code of the integrated scintilla library). Builds are formed for BSD systems, major Linux, macOS and Windows distributions.


  https://www.geany.org/news/geany-20-is-out/


  Release of the http server Apache 2.4.58:


  21/10/2023


  The release of the HTTP server Apache 2.4.58, which presents 33 changes and eliminated three vulnerabilities, two of which are associated with the possibility of a DoS-attack on systems using HTTP/2, was announced.


  https://www.mail-archive.com/announce@httpd.apache.org/msg00167.html


  Release of Libreboot 20231021:


  22/10/2023


  The release of free bootable firmware Libreboot 20231021 is presented. The update was assigned the status of a test release (stable releases are published about once a year, the last stable release was in June). The project develops the finished build of the coreboot project, which provides replacement of proprietary firmware UEFI and BIOS, responsible for the initialization of the CPU, memory, peripherals and other components of equipment, with the minimization of binary inserts.


  Libreboot is aimed at forming a system environment that allows you to do without proprietary software as much as possible, not only at the operating system level, but also firmware that provides download. Libreboot complements Coreboot for end users, forming a ready-made distribution that can be used by any user who does not have special skills.


  https://libreboot.org/news/libreboot20231021.html
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    The Ubuntu Podcast covers all the latest news and issues facing Ubuntu Linux users and Free Software fans in general. The show appeals to the newest user and the oldest coder. Our discussions cover the development of Ubuntu but aren’t overly technical. We are lucky enough to have some great guests on the show, telling us first hand about the latest exciting developments they are working on, in a way that we can all understand! We also talk about the Ubuntu community and what it gets up to.


    The show is presented by members of the UK’s Ubuntu Linux community. Because it is covered by the Ubuntu Code of Conduct it is suitable for all. The show is broadcast live every fortnight on a Tuesday evening (British time) and is available for download the following day. podcast.ubuntu-uk.org
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  The VirtualBox Networking Primer


  Connecting and Configuring Virtual Machines
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  The VirtualBox Networking Primer is a no-nonsense guide for the VirtualBox user taking their next steps into virtual networks. While Oracle VM VirtualBox is a great free tool, the real power of virtualisation comes when you start connecting virtual machines to each other and to the wider world. Software development, sales, education and training are just some of the areas in which network access to virtual machines offers endless opportunities. But the world of computer networks is filled with complex technical jargon.


  Complete with principles, practice, examples and glossary, The VirtualBox Networking Primer takes the frustration and confusion out of connecting real-world projects.


  Author: Robin Catling
 Publisher: Proactivity Press
 ISBN13 : 9781986119882


  Amazon US link:
 https://www.amazon.com/dp/1986119884?ref_=pe_3052080_397514860


  Amazon UK link:
 https://www.amazon.co.uk/VirtualBox-Networking-Primer-Connecting-Configuring/dp/1986119884/ref=sr_1_1?dchild=1&keywords=virtualbox+networking+primer&qid=1600253699&s=books&sr=1-1


  Kobo:
 https://www.kobo.com/us/en/ebook/the-virtualbox-networking-primer
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  Command & Conquer


  Written by Erik


  So, after my proofreader had gotten through the last command and conquer paper, he said that he felt a little lost.


  While that article was intended to be a high level overview and get you interested in having your own web server to play with, so you can create your own web pages, web games or whatever, I will now go over some web server-speak; I’ll focus on Nginx as it is by far the most popular. You may need it to make use of the Nginx documentation, as you, and I, as home users, do not “speak” that lingo.


  The first thing you will run into will be directives and context. Directives are specific options that get set in the configuration file (not like the tree directives that robots have in Azimov’s tales). There is a name and its value. If you ever read up on programming, think of key-value pairs or dictionary entries. It is similar to an entry in a json file. So you will have something like -


  domain: google.com, 
distribution: ubuntu,


  where “domain” is the name and “google.com” is the value, or “distribution” is the name and “Ubuntu” is the value.


  Context is a whole section in the configuration that contains directives. The directives in the section set configurations for that context. Clear as mud, eh? Back to our coding example, context is like a block of code, you can have other blocks of code nested within that specific block of code that affects only the enclosing block of code. The same with context. You can have context nested within context, that contain directives specific to that context. Still muddy, eh? Ok, think of paragraphs in a book, except here, whatever happens in that paragraph pertains only to that paragraph. For instance you read how they dig a well in that paragraph, that happens only in that paragraph; if, further in the book, you read about someone digging a well, it has nothing to do with the well that was dug earlier. Though, overall in the story or chapter, there are two wells dug, each paragraph about digging wells knows only about their specific well. Within the context or “paragraph” if I put in -


  distribution: Ubuntu, (directive)


  then in another context “paragraph”: I can put in -


  distribution: Mint, 


  it does not matter, as in that section we call the ‘context’, the key-value pair we call the ‘directive’, pertains only to that ‘context’.


  If it still is not clear, please send a message to misc@fullcirclemagazine.com


  The main configuration file is named the “main context”. Don’t ask, I did not name these things. The main context (aka config file) contains global directives (aka settings) - do I need to bring up local and global variables? You have been following our Python tutorial, haven’t you? Global directives apply to the master process.


  As I said before, context can be nested, I will highlight a few important ones, so, within the main context, you will find, for instance, the ‘server context’ (where we defined our virtual host). We also have the ‘http context’, for http-related configurations and location context, to match requests incoming to the correct server context.


  Navigate here: https://nginx.org/en/docs/http/ngx_http_core_module.html#http
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  Do you see where this jargon is used? This also tells us where you can find the directives you are looking for (hand wavy These are not the ‘droids’ you are looking for!).


  This is very important, it helps us not only read the documentation correctly, but it also helps us find where our directive should go.
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  If we look at the first example, we will find the context says it is in http, server and location, whereas merge_slashes is not found in “location”. Having it in a context where it does not belong, will mean it has no effect. If I have the above configuration in “location” context, it will not affect the “http” context even though they are both in the main context.


  I hope this has cleared up some of the confusing bits in the series, so if I ever talk about context again while talking about web servers, I mean this ^^^, not some random context or in the context of the article. Have fun with your web servers!


  
    Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he's done it.
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  HowTo: Python in the REAL World - Part 144


  Written by Greg Walters


  Greetings fellow beings. I’m back again with more Python stuff.


  As you might know, Python 3.12.0 was released on 2 October, 2023, bringing with it many new features and changes. One of the most welcome features is the more robust f-string parsing, that allows many things that would previously cause errors. I was originally planning on discussing the new release, but as I often do, I change plans. You can do an Internet search to find out more – until I get back to it.


  Then I thought that I would revisit SpeechRecognition in Python, since it was almost four years ago that I first wrote about it in Full Circle. There have been many advancements and changes, especially in the offline API routines, and more added. I had started working with a couple of the new API packages and was pretty pleased with the results.


  I was almost about to start the article when I heard from a friend with the handle of “Marvin”, from the PAGE Discord forum. He had a few questions, and the subject of a Python library named “Blessed” came up. I went to their website (https://github.com/jquast/blessed) and was really impressed with what I saw there. Think curses on steroids! One of the animated demos from a third party that uses Blessed caught my eye.
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  I’ve always enjoyed crosswords and have wanted to try my hand at creating a crossword program for quite a while, but never took the time to get started. Something always comes up.


  The third party program is named “Cursewords” and uses Blessed as its “display engine”. Intrigued, I did a web search for Cursewords and found it pretty quickly (https://github.com/thisisparker/cursewords). Once you install it with pip, it will run in a terminal by using “cursewords puzzlename.puz” where puzzlename.puz is an Across Lite formatted crossword puzzle. Probably mostly known for the New York Times puzzles that can be downloaded and run in numerous programs including Cursewords.


  The big problem is that the Cursewords distribution does not come with any puzzle files at all. This led me to do another web search for puzzles in the .puz format. I found a number of sites that had some puzzles, but many required some sort of subscription. Luckily, I not only installed Cursewords, but also downloaded the zip file from the github website. So I dug into the source code and found that it includes a module named “puz.py”. This, it turns out, is the module that reads the .puz file. Another web search turned up a python library called (remarkably enough) “puzpy” (https://github.com/alexdej/puzpy). It is the same code as the puz.py file, written by the same author that wrote Cursewords. In addition, the puzpy library includes 14 test puzzles in the .puz format that covers different types of puzzles like standard, rebus, puzzles with shapes, puzzles with notes, and locked puzzles.


  So, if you want to “hit the ground running'' and have some puzzle files for Cursewords, simply go to the puzpy github repository and download the distribution zip.


  If you are curious about the actual Across Lite file format, originally there was no documentation for the file format. However, thanks to some curious programmers, the format was reverse engineered and documented. The original documentation on this was put up on Google Code Archive (ttps://code.google.com/archive/p/puz/wikis/FileFormat.wiki) and since then has been reformatted and placed on github (https://gist.github.com/sliminality/dab21fa834eae0a70193c7cd69c356d5). If you are interested in writing applications that use the .puz format, I would suggest that you use the puzpy library to make your life easy and your development cycle much quicker.


  So that’s it for this month. Have a wonderful rest of the month.


  Until next time, as always; stay safe, healthy, positive and creative! Greg


  
    Greg Walters is a retired programmer living in Central Texas, USA. He has been a programmer since 1982 and in his spare time, he is an author, amateur photographer, luthier, fair musician and a pretty darn good cook. He still is the owner of RainyDaySolutions a consulting company and he spends most of his time writing articles for FCM and tutorials. His website is www.thedesignatedgeek.xyz
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  HowTo: An introduction to Stable Diffusion - Part 8


  Written by Jon Hoskin


  In part eight of An Introduction to Stable Diffusion, we will look at the new release of Stable Diffusion 1.0 (SDXL). The article starts and concludes with two images generated with the new version of Stable Diffusion via Automatic1111. Generating 20 random seeded images, 1024 x 1024 px, with the three-word prompt of Full Circle Magazine, the images highlight the creative possibilities of this software. Text remains an issue with the free version although text was not specified as part of the prompt.
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  I upgraded to a more capable graphic card which also required an additional upgrade for the power supply. Thinking that it might be a good idea to start with a fresh install of the OS (Kubuntu) - that is when the fun started. I almost always use Ventoy (https://ventoy.net/en/index.html) to install any of a variety of distros to machines to either try or install Linux. Inevitably, I now saw a “Bluetooth and malformed MSFT vendor problem” error. The OS would not start.


  Upon searching the Internet, I found it to be a very common problem. There were some quirky workarounds, but obviously they were not the answer. Even when using the workaround, I would find that it would never come out of sleep mode, just a blank screen that would require a reboot.


  Noticing an error referring to not having the appropriate Nvidia driver, I noticed the graphics driver was an Open Source version. After installing the suggested proprietary driver and rebooting, everything seemed to be working fine. I did experience a few glitches, but it was nevertheless much more stable. An Internet search found negative comments about Nvidia drivers and suggested use of AMD cards although after an update which included Nvidia drivers, it seems even more stable.


  I was expecting the Easy Diffusion (ED) install, now at V 3.0.6, to be the one-click experience as before (https://github.com/easydiffusion/easydiffusion#installation). However, it required CURL to be installed on my now Kubuntu OS. Otherwise, it installed everything as needed. The safe sensors models are considered safer and SD-V1-5 gets installed in the models subdirectory under stable-diffusion. Although version 3.X will run the SDXL models, it needs to be downloaded and added to that same subdirectory. In my mind, the new Interface is a bit spartan. Users need to know to select the image settings button to choose appropriate options, and to select the +Image Modifiers button to select from those options.
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  The Automatic1111 interface version installed easily as before (https://github.com/AUTOMATIC1111/stable-diffusion-webui). The SDXL 1.0 models must also be separately downloaded, or copied from the ED install (https://github.com/AUTOMATIC1111/stable-diffusion-webui/wiki/Features). You can check for updates by selecting Extensions at the right end of the tabs of the interface. It opens with the Installed tab selected showing a variety of options preselected. The Check for Updates button will do that, and you can update any option to the current version using the Apply and restart UI button.
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  I mentioned previously that Automatic1111 is a very popular interface for SD. One reason for that is that many additional options are available. These may be accessed via the same extensions tab, then selecting the Available tab option and the Load from: button. That will load the available options from the default Extension index URL. More than one hundred options will appear – which is a bit overwhelming given that an SD novice may not be familiar with the vocabulary. (Helpful for anyone is the Definitive Stable Diffusion Glossary: https://theally.notion.site/The-Definitive-Stable-Diffusion-Glossary-1d1e6d15059c41e6a6b4306b4ecd9df9.) A portion of the options are shown and I installed the Style Selector for SDXL 1.0. Selecting the Install button adds that option and changes the button to Installed as shown.
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  Installing the Style Selector for SDXL 1.0 extension option results in a choice of button prompt selections. It can be enabled in the interface by selecting the small triangular button at the far right of the SDXL Styles tab near the bottom of the Automatic1111 interface as shown. You can enable the style selector as shown. The styles can then be selected individually by selecting the checkbox for each. You can also generate images of all the options by selecting Generate all Styles In Order, which uses the prompt you have input.
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  The image below is another of the Full Circle Magazine images generated as noted at the beginning. In both cases they look like magazine covers albeit the text language would not be recognized. The ninth part of this introduction will look at other possibilities.
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  HowTo: Latex part 25 - Bibliography and References


  Written by Robert Boardman


  This time we are going to expand the “back matter”of the book even more. I started working with the sample cookbook in Full Circle Magazine #194, and continued in #195 and #197. (Sorry about missing #196, there were other important things I had to deal with.) If you have been following along, you should now have a small book with a number of recipes, a very short glossary, and an index. There are section dividers and a table of contents. This time, I am going to add sources to the recipes and build a bibliography.


  A bibliography is a necessary part of any academic paper, whether it is published in a peer-reviewed journal or an assignment submitted to a teacher. The basic rule for references is simple. If the words or ideas included in your paper were written by someone else you have to use a reference, you have to give credit where credit is due. Not to do so means you claim their words are your words. You are lying, misrepresenting the truth. Portions of your paper, article, book, have been copied from someone else. Officially this is called plagiarism, also known as cheating.


  The recipes I included in the sample cookbook I collected from email and various web sites. Most of them I have had for more than ten years. However, they are not my work. I do not know the sources for any of them. I do not claim they are my work. In this issue, I will provide the recipes with fictional sources of various kinds.


  If you have had to write something that included at least one other person’s words, you should know there are different ways to indicate the source of other persons’ words. The oldest way was to use numbered footnotes at the bottom of the page where the quoted material appeared, and then a complete listing of all sources in a bibliography (list of references) at the end. More recently, endnotes have become acceptable in many publications. They are similar to footnotes in that they are numbered in the text but the list of notes appears either at the end of the chapter (less common), or at the end of the book. Sometimes, the numbering was sequential from beginning to end. Usually in a book, the numbering restarted at 1 at the beginning of each chapter and the list of endnotes was divided by chapter. For many years, the standard in scientific papers has been inline references (or citations) plus a bibliography at the end of the book.


  There are “style sheets” for various types of citations and reference lists: APA, Chicago, MLA, etc. Every publication and every publisher will have a style for references. The style chosen might be their own custom style. More likely, they will use one of the well-known standards either as is or with a few modifications that make it more suitable for its intended audience.


  There are more than 1.5 pages of references in the index to The Latex Companion dealing with bibliography. There are another two pages for references for “cite” and “citations”, and half a page of references for database management for bibliographies. Volume 2, chapter 15, deals with bibliographies, and chapter 16 deals with citations, over two hundred pages of text. You should conclude from all these numbers that this is a very valuable and complex feature in Latex.


  There are two major programs used by Latex to build bibliographies: Bibtex and biber. I am going to use the tools and commands used in Bibtex. I would prefer to use biber, because it supports Unicode. However, that would mean rebuilding my bibliographic database.


  The first step in building a bibliography is to have sources to include in it. One way is available in TexStudio but not in Gummi (the two Latex GUIs I have on my system): a Bibliography menu. When selected, it shows a long list of different types of sources. Pick the one that is most relevant to your source, and fill in the blanks. What you are building is a one-table, multiple-field database. Before you select the Bibliography menu, you must open a new file in TexStudio (or open an existing bibliography database file). The file must be saved using “bib” as the file type. For ease of use, name it the same as the principle file and save it to the same directory as the principle file. (The name and location can be different than suggested, but you should have a good reason to do so.)


  Once the file has been opened (and possibly saved), select the type of reference from the Bibliography menu in TexStudio and then fill in the information. Optional information is indicated with OPT at the beginning of the field name, required information is not. If you do not complete the required information, you will get a compilation error. Optional fields that do not have user information can be left as-is or deleted.


  Each record in the bib file will start with an ampersand @, followed by the name of the type of source, then a curly brace. Immediately after the curly brace you should supply a unique value (name) for the source. You can name a source anything you wish. I suggest you use something you will remember since it is this identifier that is used in the cite instruction in the body of your article or book or whatever. I normally use the author’s last name, unless I have two or more sources from the same author, and then I might include a year or part of the title of the source. (A little more about this when we get to the cite instruction.)
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  Another way to add records to the bib file is to copy them from an online source. Many books and journal articles have included bibliographic information in various formats on websites. Google Scholar is one place to find such information. Even if you own the source, sometimes it is easier to copy and paste the required information from a website to your bib file than to type it all yourself. Often the bibliographic information online is more complete than what you might type. I looked up a book I own on books.google.ca, and found bibliographic information in three formats: BibTex, EndNote, RefMan.


  Once you have at least one source recorded in a bib file, you need two more steps to make the bibliography appear in the PDF of your document, well three steps if you count compilation, which is always the last step before the PDF appears. These two steps can be completed in any order.


  Step 1: Cite the item in the appropriate place in your document. Step 2: Add instructions to the document so the bibliography appears where you want it.


  At the end of the master document of the cookbook, I inserted the two necessary instructions to get the bibliography to appear after the glossary and before the index.


  \bibliographystyle{alpha}
\bibliography{fcm198index}
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  These two instructions are both required. However, the options inside the curly braces will change. Remember I said the bib file is best named the same as the main document file. See the {fcm198index} instruction. That points to the fcm198index.bib file saved in the same directory as the main document. If you decide to save it with a different name, myrefs.bib for example, that name would appear as \bibliography{myrefs}. If you also saved it in a different directory, the path to that directory must be included inside the curly braces.


  The bibliographystyle{alpha} is also required. It tells Latex how to set up the citations in the body of the document and how to set up the bibliography. {alpha} is the default style, which I do not like very much. I am used to using either APA or MLA, or some form of scientific-style citation. There are several built-in bibliography styles, and many other packages can be obtained from ctan.org. I did not want to load this issue with a lot of screenshots. If you are interested, I suggest you take a look at any of the following styles: plain, acm, apalike, ieeetr. To find out what bibliography styles are installed on your computer, do a search for files of type bst. My standard Latex installation has at least two hundred *.bst files.


  In order to have a bibliography, the document (in our case at least one of the documents) must contain a citation, a place in the text which refers to the source. The instruction for a citation is \cite. If you use TexStudio and have compiled the PDF when you type the instruction \cite, TexStudio will show you a list of entries from the bib file so you can pick one instead of trying to remember which identifier is appropriate at this point in your document.


  As an example, the Chinese Sesame Buns recipe has a reference to Fuchsia Dunlop’s book. In the tex file, the reference is \cite{Dun19}. This citation points to item Dun19 in the bibliography. (This recipe has nothing to do with Fuchsia Dunlop, I use it only as an example.)


  
    [image: fcm198index.cite]
  


  The last step in generating a PDF file from the Latex code is to compile the document. As with the index, a document with a bibliography has to be compiled at least three times. The first time and the third time are standard, the second time compiles the information for the citations and the bibliography. Again, TexStudio is very helpful with a Bibliography (F8) item in the Tools menu. Since compiling a standard document takes very little time, doing this three-step process does not slow down document production very much. If you have made changes to citations or sources, you must do the three-step recompile to update the final PDF. (Of course, if you have changed the indexing items as well, you must also recompile for the index, making this a four-step process in TexStudio.)


  Next time, I will show how to make the chapter titles clickable “live links”. Readers will not need to scroll through pages or use PDF Find in order to navigate through your thesis or cookbook or whatever.
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  How-To: Drawing with Inkscape - Part 138


  Written by Mark Crutch


  Last month, I took a look at the new Shape Builder tool in Inkscape 1.3, which offers a very convenient way to perform various Boolean operations. Unfortunately, it also tends to create a lot of extra nodes, so for some workflows, there’s still a benefit to using the suite of Boolean operations under the Path menu. For users who wish to use those tools, I’m happy to report that Inkscape 1.2 and 1.3 both extended them a little.


  Before I proceed too far, a note for the pedants: I’ll refer to all these tools under the umbrella of “Boolean operations” for convenience. Technically speaking, the true Boolean operations are those that are based on Boolean algebra – a branch of mathematics named after George Boole, who formalised it in 1847. Only a few of the tools in the Path menu actually work in a strictly Boolean manner. But given that those tools are concerned with creating new shapes by combining and removing overlapping parts of multiple paths, it makes sense that other tools which achieve similar goals are grouped with them in the same menu. So for the purposes of simplicity, all the shape manipulation tools under the Path menu are Boolean operations as far as this column is concerned.


  This month, we’ll look at the first new addition, which was introduced in Inkscape 1.2: Path > Split Path. This is a little like the existing Path > Break Apart feature, except that it breaks paths apart in a way that probably makes more sense – and will be more useful – to most people. Let’s start with a very simple example: here I’ve used Path > Difference to cut one circle out of the center of another, creating a donut shape. I’ve then duplicated the donut, and used Path > Combine (or Path > Union) to convert the whole arrangement into a single, complex path. As a quick reminder, I use the term ‘complex path’ to refer to any path which is made up of multiple sub-paths.
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  With the Node tool active, you can see from the image that there are four sub-paths, one for each dark-red circle, and each consisting of four nodes. Let’s suppose that a little later we decide that it would be better to separate these objects in order to move them around independently. In previous versions, a naive user might reach for Path > Break Apart, only to be rather disappointed with the result.
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  Break Apart reduces a complex path to a collection of individual simple paths, by breaking each sub-path out into a separate object. In this case, we end up with four separate path objects, but because the larger paths no longer have a hole in the middle, their fill obscures the fact that there are a couple of smaller paths behind. Sending the outer circles down in the z-stack makes things a little more obvious – this screenshot leaves the left-hand circles untouched, but moves the large right-hand circle to the bottom of the stack.
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  That may have made it a bit clearer what has happened, but it doesn’t really get us to the result we wanted – two separate donuts. For that, we have to select the two circles on the left and use Path > Combine, followed by doing the same to the two circles on the right. Finally we have two complex paths, each representing a single donut, which can be moved independently.


  
    [image: ink4]
  


  In this particular case, a user who is already familiar with the behaviour of Break Apart might have chosen to duplicate the original and cut half the content out from each copy using direct node editing, or some other Boolean technique that involves creating a quick sacrificial cutting shape. But for a more complex shape with lots of sub-paths, those approaches can quickly become unwieldy. Whichever approach you take, there’s no doubt that it’s a lot of steps just to split two visually separate objects into individual complex paths.


  Now let’s try the same thing using Path > Split Path. Starting with our complex path containing four sub-paths, applying this function gets us directly to the desired outcome (the same as the previous screenshot), with no additional fuss. Perfect!


  Of course Inkscape isn’t able to read your mind to determine how you want it to split your four sub-paths, and there are still cases where Break Apart might be the better option, so it’s important to understand the logic used within this new feature. Quite simply, it breaks your path based on whether the sub-paths overlap or not. Any group of overlapping sub-paths will be split out into a new complex path. An individual sub-path that doesn’t overlap with any other sub-path will be split out into its own new simple path. The net result is that a previously complex combination of shapes will be broken up into independent objects, based (broadly) on how visually separate they are.


  An example with two donuts makes for a good introduction, but when would you actually want to use this feature in a real design? Perhaps the most common situation is when trying to split text (which has been converted into a path) into individual glyphs. In typographical terms, some characters have ‘counters’ – the closed shape in the middle of an ‘o’ or ‘p’. These don’t fare so well when Break Apart is used.
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  Use Path > Split Path, however, and the result is a lot closer to what you probably wanted.


  
    [image: ink6]
  


  Be aware, however, that it’s not perfect. Inkscape doesn’t know that this path represents characters, and Split Path just separates out the non-overlapping paths, so any glyph that is made up of non-overlapping parts will result in more than one path being created. You can see this with the ‘i’ or the ‘!’ which are each split into two separate paths and need to be re-combined manually (with Path > Combine or Path > Union). It’s still a lot less post-processing than with Break Apart, but don’t think that the new feature is a complete panacea.


  Another gotcha with this feature is Inkscape’s notion of what constitutes a non-overlapping path. Consider this variation on our earlier donut, this time with an additional ‘island’ in the middle.
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  What do you think Path > Split Path will do in this case? It’s pretty clear that the nodes for the island are all inside the outer sub-path, and therefore can be considered to be overlapping. Sure enough, Split Path has no effect on this shape at all. But what about this one?
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  This time the outer shape has a tiny gap in it on the right-hand side. The thick stroke disguises it somewhat, but it’s there. To the human eye, you might still consider the island to be ‘inside’ the shape, but, mathematically speaking, it’s not. Inkscape goes with the mathematical definition, so using Split Path results in two objects, not one.


  Now let’s extend that example a little further by moving the ends of the broken shape so that they cross.
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  From a human perspective the island is most definitely inside the shape this time. But, again, in mathematical terms, the two paths are not overlapping, so Split Path results in two separate objects. All of which is to reinforce the fact that this feature is more likely to give the desired result than Break Apart, but it still needs to be treated with care to ensure it has split things the way you want, especially when there are features that could end up as separate objects even if they give the appearance of being inside a larger shape.


  I really wish this tool had been available a few years ago, when I was writing a weekly comic strip for my local newspaper. I created it in collaboration with Vince, a far more artistically competent friend. In order to turn the strips round quickly, he would draw the various elements of each comic separately on a sheet of paper, and I would then scan the entire sheet and trace it with Inkscape. Here’s an example of a typical character sheet, after scanning and tracing.
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  The problem here is that Inkscape’s Trace Bitmap feature produces a single complex path for the entire traced image. In this case the path consists of over 15,000 nodes! Part of my job was therefore to create numerous duplicates of the traced image, each overlaid with a different cutting path. Path > Intersection was then used on each pair, removing all the parts that were not covered by the cutting path in each case. The final result was a separate complex path for each character or part on the sheet.


  So how does Path > Split Path fare when faced with a task like this? Not at all badly, it turns out.
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  The first three images are perfectly cut out, and ready to go. The last one on the top row requires a small amount of re-combining to ensure that the shadow and the movement marks all remain with the character. The bottom row did a little worse, though it’s hard to see from this screenshot. For each head there are some small elements – a wart here, an eye there – which have been split into separate paths. These are all due to the fact that the neck is not closed off, resulting in what Inkscape sees as an open shape, much like the broken circle I presented earlier. A little re-combining fixes the issue, but in reality we would have quickly learned that, while drawing, Vince should close the end of the shape in such situations, reducing the problem going forwards. Across dozens of character sheets and pages of props and backgrounds, Split Path would have saved me many, many hours of manual path tweaking.


  If you frequently work with complex paths, text-as-paths, or bitmap traces, I hope you can see how this feature might be a game-changer for your workflow. Compared with the alternatives, it will often do a better job with less complexity and confusion. Even in those cases where the results aren’t perfect, they’ll probably be more understandable to most users than the confusing mess that Break Apart often appears to make of things.


  Next month, I’ll continue this theme, to take a look at the new Boolean operations that were added with Inkscape 1.3.


  
    Mark uses Inkscape to create comics for the web (http://www.peppertop.com/) as well as for print. You can follow him on Twitter for more comic and Inkscape content: @PeppertopComics
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  Everyday Ubuntu:


  Written by Richard Adams


  Back next month


  
    Richard 'Flash' Adams lives in rural north Alabama and has been a computer support technician, a business analyst,a software salesman, a sales analyst, a QC team lead, and is now disabled/retired. He enjoys reading, NFL football, computer and video games, cooking, and playing with Baby, his cockatiel. Feedback and suggestions are welcome at acer11kubuntu@gmail.com.
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  Micro This Micro That – Part 23


  Written by Greg Walters


  Micropython 1.21 Released!


  Greetings again, fellow Beings!


  Usually, I have a plan for what I’m going to write about each month and this month is a normal month. AND, and as normal, the original plan 80% of the time is not what actually gets into the article.


  I WAS going to give an update on the WIO terminal and the progress that I’ve made on the screen display coding. However, as you will see, stats don’t lie.


  On October 6, 2023, Micropython.org released version 1.21. This is a major upgrade, just as 1.20 was.


  Just some of the things that have changed in version 1.21 include (from the release notes) :


  “This release of MicroPython sees the renaming of built-in modules to remove the u-prefix, a new deflate module with optional compression support, the introduction of board variants, switching of the esp32 port to use IDF 5 together with improved heap management, support for BLE on RPi Pico W boards, and STM32H5xx support. The project is also now using codespell and ruff to improve code quality. New boards added in this release are: ARDUINO_NANO_ESP32 and UM_NANOS3 (esp32 port), ADAFRUIT_METRO_M7 (mimxrt port), ARDUINO_PORTENTA_C33 and VK_RA6M5 (renesas-ra port), ADAFRUIT_METRO_M4_EXPRESS (samd port), NUCLEO_L4A6ZG and STM32H573I_DK (stm32 port).”


  To load it onto your board of interest, download the latest build (https://micropython.org/download/ ) and either you Thonny or RShell and in the REPL type:


  machine.bootloader()


  This will get you the file manager window that you can drag and drop the new firmware into. Assuming you are running Thonny, once the microcontroller reboots you’ll see the new version information in the REPL. Otherwise, when you plug into the board and go enter the REPL, you’ll see the new version.
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  I’ll try to break down just some of the “generic” enhancements and we’ll look at some of them in future articles.


  ESP-NOW


  According to the espressif ( https://docs.espressif.com/projects/esp-idf/en/latest/esp32/api-reference/network/esp_now.html ), ESP-NOW is a kind of connectionless Wi-Fi communication protocol that is defined by Espressif. In ESP-NOW, application data is encapsulated in a vendor-specific action frame and then transmitted from one Wi-Fi device to another without connection.


  I’ve been reading about ESP-NOW for a while, and have wanted to test it, but between time constraints and other projects, I’ve just never gotten around to playing. Now that it is fully supported by Micropython, I will start concentrating on it and will try to give you some information on it in the next month or so.


  Enhanced support for python f-strings


  Micropython has supported “normal” python f-strings for a while, but for the life of me, I can’t find any information as to what version was the first to get f-strings. That having been said, there have been some additions to the f-string support. Mainly support for conversion specifiers like “!r”.


  If you are not familiar with conversion specifiers, take a look at the following snippet…


      def do_scan(which):
        i2c=I2C(which)
        print("I2C Configuration: "+str(i2c))
        devices = i2c.scan()
        for device in devices:
            print(hex(device))


  This is the “old” way to print strings. The output from the print statement (passing which=1) would look like this…


  I2C configuration: I2C(1, freq=399361, scl=7, sda=6, timeout=50000)


  Now, if we change the print statement to use f-strings, it would look like this…


          print(f"I2C configuration: {str(i2c)}")    


  This output looks identical to the “old” way.


  Trying the new “!r” conversion flag, you would code it this way…


          print(f"I2C configuration: {i2c!r}")


  And guess what, the output is exactly the same yet again.


  I2C configuration: I2C(1, freq=399361, scl=7, sda=6, timeout=50000)


  So why bother. Well, the answer is that you can use str(i2c) or repl(i2c) and get the same kind of output. But, the strings returned by the two functions, which most times will look the same, are two different types.


  Max Brenner (https://shipit.dev/posts/python-str-vs-repr.html ) says:


  The following clues might help you to decide when to use which:


  


  
    
      
        	
          str()
        

        	
          repr()
        
      

    

    
      
        	
          - make object readable
        

        	
          - need code that reproduces object
        
      


      
        	
          !- generate output for end user
        

        	
          - generate output for developer
        
      

    
  


  BLE in RPi-W


  BLE has officially been added in Micropython 1.21 for the RPi-W board. While this has been in the nightly builds for a while, it now is in the official release. We’ll be looking at this in future articles.


  So that’s it for this month. I know this is shorter than normal, but I’m saving up for next month ;o) .


  Until then, as always; stay safe, healthy, positive and creative! Greg


  
    Greg Walters is a retired programmer living in Central Texas, USA. He has been a programmer since 1982 and in his spare time, he is an author, amateur photographer, luthier, fair musician and a pretty darn good cook. He still is the owner of RainyDaySolutions a consulting company and he spends most of his time writing articles for FCM and tutorials. His website is www.thedesignatedgeek.xyz
  


  


  
    [image: Contents]
  


  


  
    [image: Linux_On_Your_IPad_Shells_Edit]
  


  


  
    [image: Contents]
  


  UBports Devices: OTA-2[image: phone]


  Written by UBports Team
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  My Opinion: Three Ways to Try Linux (3) – Dual Booting


  Written by Alan German


  In recent articles in this series, we have explored some of the features of Linux using a live-USB, and have taken a more in-depth look by installing Linux on a virtual machine (VM) on a Windows 10 host. Both of these methods allowed us to try Linux without really affecting the operations of our Windows machine. The live-USB didn’t change Windows at all, while the VM was created on a program (VirtualBox) installed on the Windows computer, just like any other application. This time, we are going to actually install Linux on our computer’s hard disk. However, we will use separate partitions for Windows and Linux, and be able to dual-boot between the two operating systems. So, the only real change for the Windows system will be a little less available disk space.


  But, first things first. Before making such a radical change to our working system, we should make a full disk image backup. A previous article (Rescuezilla For Backups; Full Circle Magazine; No. 190; pp. 21-22) described a software package appropriate for this task. Store the backup image on an external USB drive so that it is completely separate from the system disk. Then, should anything go wrong with the installation of Linux or, should you decide that dual-booting isn’t for you after all, the disk image can be restored and your entire system very quickly and easily restored to the point in time when the image was made.


  We already have the necessary tools and experience to install Linux on the hard drive, and just need to adopt a small modification to the previous installation process. We will use the bootable USB drive that we used to try out Linux in live-USB mode. However, this time, when the Linux desktop loads, we will double-click on the Install Linux Mint icon in order to start the process of installing Linux to the hard disk.


  The installation process continues exactly as it did when we installed Linux on the virtual machine that we had created with VirtualBox. However, when we reach the point where we need to select the disk drive on which Linux is to be installed, this time we don’t want to use the entire system disk. Rather, we want to accept the default option of Install Linux Mint alongside Windows Boot Manager. This selection will have the installer take some of the free disk space from Windows, create a separate partition, and install the Linux OS and the included apps on this new partition.
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  For most users, the system disk will be quite large and, even with Windows, all of the installed applications, and the user’s data files, there will still be lots of free disk space available. The Linux installer will normally partition the disk completely automatically with no further action being required by the end user. For example, on my laptop, with a 250 GB drive, Windows was using about 150 GB, and the Linux installer carved off about 60 GB of which 11 GB was used by the OS and the apps bundled with the distro, leaving the balance as free space.


  When the installation is complete, selecting the option to Restart Now causes the computer to reboot and, because we opted to install Linux alongside Windows, we now see the GRUB (Grand Unified Bootloader) boot menu that allows us to select the operating system that we wish to use.
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  By default, the entry for Linux Mint 21 Cinnamon will be selected and the GRUB menu will be displayed for 10 seconds before Mint is automatically booted. Scrolling down the menu to the Windows Boot Manager stops the countdown, and pressing Enter results in the machine booting into Windows 10. Note also that, if we really do wish to boot into Mint, we can simply press Enter initially. This overrides the countdown process and boots into Linux immediately.


  Now, we have the best of both worlds. We have a fully-functional Linux installation running directly on the system’s hardware. and have also retained the option to boot into our Windows system should we so wish.


  This completes the current series of ways to try out Linux without compromising a Windows installation. I hope that it has given anyone who is considering switching away from Windows 10 in 2025 (or before!) all the tools required to try using Linux well ahead of the end-of-life deadline.


  
    Alan is a computer enthusiast based in the Great White North where he maintains LinuxNorth blog at: https://linuxnorth.wordpress.com
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  How-To: Write For Full Circle Magazine


  Written by Ronnie Tucker


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives—Kubuntu, Xubuntu, Lubuntu, etc.


  The Official Full Circle Style Guide can be read at: http://bit.ly/fcmwriting


  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression. When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don’t worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we’ll help you with your English!


  
    Reviews


    Games/Applications:


    When reviewing games/applications, please state clearly:


    
      	title of the game


      	who makes the game


      	is it free, or a paid download?


      	where to get it from (give download/homepage URL)


      	is it Linux native, or did you use Wine?


      	your marks out of five


      	a summary – with positive and negative points

    


    Hardware:


    When reviewing hardware, please state clearly:


    
      	make and model of the hardware


      	what category would you put this hardware into?


      	any glitches that you had while using the hardware?


      	easy to get the hardware working in Linux?


      	did you have to use Windows drivers?


      	marks out of five


      	a summary – with positive and negative points

    

  


  
    You don’t need to be an expert to write an article – write about the games, applications and hardware that you use every day.
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  Review: Ubuntu Budgie 23.04


  Written by Adam Hunt


  The latest from the Ubuntu Budgie team is version 23.04, which came out on 20 April, 2023. This is the distribution’s 14th release, and is the middle one of three interim releases in this development cycle, leading to the next Long Term Support (LTS) version, Ubuntu Budgie 24.04 LTS, due out in April, 2024.


  After a busy release last time, with many default application changes, this release just includes some smaller adjustments.


  As an interim release, Ubuntu Budgie 23.04 is supported for nine months until January, 2024.
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    Ubuntu Budgie 23.04 default desktop

  


  Installation


  I downloaded Ubuntu Budgie 23.04 via BitTorrent from the official sources. The download was 3.4 GB, which by current standards is a modest size. Certainly, it is much smaller than the mainstream Ubuntu 23.04 at 4.9 GB or Kubuntu 23.04 which tips the scales at 5.0 GB.


  Once downloaded, I carried out a command-line SHA256 sum check on the ISO file to make sure it was good, and then dropped it onto a USB stick equipped with Ventoy 1.0.91. Ventoy makes testing out Linux distributions really easy as it does all the hard work of unpacking on boot-up.
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    Ubuntu Budgie 23.04 defauilt Pocillo-dark theme

  


  System requirements


  The recommended system requirements for Ubuntu Budgie 23.04 have not changed and are:


  
    	4GB or more of RAM


    	64-bit capable Intel and AMD processors


    	UEFI PCs booting in CSM mode


    	Modern Intel-based Apple Macs
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  New


  This release reflects a fair amount of work put in by a number of Budgie developers in a few specific areas.


  Ubuntu Budgie 23.04 uses Budgie desktop 10.7.1 which is a fresh version. Many of the desktop applets (widgets) have seen fixes and improvements including the Clockworks applet and the weather applet, which have better theme integration and scaling.


  There has also been a concerted effort to improve and expand hot corners, hotspots, and the associated Window Shuffler, which all provide window tiling effects. For instance, when you move a window to the top of the screen it expands to full width and half the screen vertically. There must be users, or at least developers, who revel in these sorts of effects, but personally I really detest them as distracting and annoying, and so I always turn them off.


  The default wallpaper is finally an (almost) new design. Previously, the wallpaper had been the same since Ubuntu Budgie 19.04 and was starting to look like a real distribution fixture. This time around, the developers took the stock wallpaper and added a lobster star constellation in honor of this release’s Lunar Lobster codename. There are 13 wallpapers provided, but only one with a lobster!


  There are also a large number of otherwise small changes and refinements in this release.
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  Settings


  Ubuntu Budgie 23.04 brings many theme updates, adjustments and reworks. As in past releases, the settings are scattered over many different places, although everything is there; it just takes some time to learn where to find it.


  Budgie Desktop Settings is where you find the window themes, oddly, under Style - Widgets. There are 14 window themes provided, with the default one still Pocillo-dark. There is also Pocillo-light which is quite inspiring for fans of lighter themes. The Pocillo family of themes also come in “thin” versions which make the top bar smaller.
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  Budgie Makeovers & Layouts is where you find one button wallpaper, window theme, and icon packages. There are still eight of them to choose from although only one is installed and the others have to be downloaded for installation if needed.


  Budgie Extras is where the desktop applets are hidden. There are now 36 applets included, three less than in the last release. These add things like clocks and other functionality to the desktop. On Kubuntu, they would be termed "widgets".


  The main menu continues to offer the choice of a switchable icon view and a list view, as well as an application search bar.
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  Applications


  Some of the applications included with Ubuntu Budgie 24.04 are:


  
    	Archive Manager (File Roller) 43.0 archiver*


    	Atril 1.26.0 PDF viewer*


    	Budgie Screenshot Applet screenshot tool


    	CUPS 2.4.2 printing system*


    	Deja Dup 44.0 backup tool


    	Document Scanner (Simple Scan) 44.0 optical scanner


    	Drawing 1.0.2 image editor


    	Firefox 111.0.1 web browser**


    	Goodvibes 0.7.6 internet radio


    	Gnome Disks 44.0 disk manager


    	Gnome Software 44.0 package management system


    	Gparted 1.3.1 partition editor*


    	Gpodder 3.11.1 podcast player


    	gThumb 3.12.2 image viewer*


    	Guvcview 2.0.8 webcam application*


    	LibreOffice 7.5.2 office suite


    	Lollypop 1.4.37 music player


    	Mate System Monitor 1.26.0 system resource monitor*


    	Nemo 5.6.3 file manager


    	Parole 4.18.0 movie player


    	Pipewire 0.3.65 audio controller


    	Text Editor (gedit) 44.2 text editor


    	Thunderbird 102.10.0 email client


    	Tilix 1.9.5 terminal emulator*


    	Transmission 3.00 bitTorrent client*

  


  *indicates same application version as used in Ubuntu Budgie 22.10


  ** supplied as a snap, so version depends on the upstream package manager


  After a number of application trade-outs in the last release, it looks like the team may have settled on a new default suite of applications, as this time around there are no application changes, just updated versions. The current set is a real mix from Gnome, Cinnamon, MATE, Xfce, and other projects, though.


  Ubuntu Budgie 23.04 uses the Cinnamon desktop’s Nemo file manager instead of the standard Gnome file manager, Nautilus (Files). Nemo has a nice intuitive interface, including an “up one level” button, and works fine in every regard, except that it is missing bulk file renaming. This is a fairly important feature for a file manager to still be lacking here in 2023.


  Ubuntu Budgie 23.04 includes the LibreOffice 7.5.2 office suite which is complete except for the LibreOffice Base database program. It is probably the least-used part of LibreOffice but can be installed, if desired.


  This release still has the standard Budgie application dock, Plank, which is easy to configure or even turn off.
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  Conclusions


  Ubuntu Budgie 23.04 is certainly a solid release with no obvious vices, other than its rather scattered user settings. I am sure most seasoned Budgie users know where to find everything, but, for new users, there is a bit of a learning curve here.


  Ubuntu Budgie continues to appeal to users looking for more of a classic, menu-driven operating system than Ubuntu or Ubuntu Unity. This places it in a similar class as Lubuntu, Kubuntu and Xubuntu.


  We are expecting the last interim release for this development cycle on 12 October, 2023, and then it is onto the final result of this cycle, Ubuntu Budgie 24.04 LTS, due out in April, 2024.


  External links


  Official website: https://ubuntubudgie.org/


  
    Adam Hunt started using Ubuntu in 2007 and has used Lubuntu since 2010. He lives in Ottawa, Ontario, Canada in a house with no Windows.
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  Review: Pop!_OS 22.04 LTS


  Written by Adam Hunt


  Pop!_OS 22.04 LTS has been around for a bit, having been released on 25 April, 2022, but it is still the current version and there is a story here that is worth telling.


  I was recently trying out Pop!_OS 22.04 LTS, after having installed it on my System76 Galago Pro laptop. This computer had been running Ubuntu 22.04 LTS and Lubuntu 20.04 LTS before that, but I was looking for something a bit better, and Pop!_OS looked like it might be the answer.
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  While Full Circle has carried some Pop!_OS news over the years, the last release review we ran was back in October 2017, in Full Circle 126, and that was of Pop!_OS 17.10 beta, the very first release. It seemed high time for a fresh look at where this interesting Linux distribution is right now and, even more so, where it is heading, because there are exciting developments afoot.
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  Background


  Pop!_OS is a project of System76, a US computer hardware builder that was founded in 2005 and is based in Denver, Colorado. The company sells only Linux-equipped hardware and fills a fairly brisk niche market.


  From its inception, System76 has shipped computers with Ubuntu installed although they encouraged customers to install their favorite Linux distributions as well. In those days, Ubuntu used the Gnome 2 desktop, but by 2011, the Ubuntu interface had switched to Unity as Ubuntu avoided the early days of the Gnome 3 desktop and all the teething troubles that it brought. System76 was happy to ship Ubuntu with Unity until the long-promised Unity version 8 failed to materialize.
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  In 2017, seeking company profitability, Ubuntu’s sponsor, Canonical, announced it was ending development of Unity and switching to a modified Gnome 3 desktop that would consume a lot less internal company manpower. In a blog post, the System76 leadership said: “We were shocked. Development of the product we’ve shipped since 2011 would cease. Unity was no more … There was some relief. Most System76 employees were using different desktop environments at this point. Just keeping my team excited about Ubuntu had been hard for a while. We’re technologists, and we felt Ubuntu drift. I agreed with the Canonical strategy of maintaining Unity 7 while developing Unity 8 separately. But time dragged on and we were stuck between waiting for our new product, which sounded constantly just around the corner, and investing in Unity 7 that was on its way out. There were no good decisions. Just hold the line. That’s not comfortable for an ambitious company. Now, with Unity canceled, the world was wide open again.”
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  So, what to do? Canonical was successful in keeping the focus of Ubuntu in the “enterprise market”, and getting it into business and government offices along with paid support services. From customer surveys, System76 knew their customer base for Linux laptops was different – with many of their users working in science, aerospace, medicine, and robotics. There was an opportunity to create a new operating system for these customers and the company leadership decided to go their own way, start a new Linux distribution and offer it alongside Ubuntu, giving the customers a choice when ordering new hardware.


  They decided to stick with the Gnome application stack, thin out the list of included default applications to cut down the “consumer” items like music players and games like solitaire, and create a modified desktop. 17.10 was the first release, out in October, 2017, and based on Ubuntu 17.10. Pop!_OS starts from a base of Ubuntu, with the same twice yearly, April and October releases and the same long term support editions every two years. From their blog posts, it seemed that enthusiasm at the company was high as the in-house development team dived into the project.


  Development moved along quickly with serious changes rolled out even to existing releases, almost like a rolling release model. The seventh release, 20.10, brought a new desktop dubbed COSMIC (a backronym for Computer Operating System Main Interface Components) – with a highly configurable dock and many new keyboard shortcuts. By the time the tenth release, 22.04 LTS, was out, it had user-definable keyboard shortcuts, mouse gesture menu access, and a high degree of customization available. New items in this release included a customer support panel to connect users to System76, a choice of light and dark window themes, enhanced CPU performance with the System76 Scheduler, an improved Pop!_Shop software store, the audio controller moved to PipeWire instead of PulseAudio, and new robot-themed user icons.
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  Some reviewers have compared Pop!_OS to MacOS, as both are operating systems provided by hardware builders on the computers they sell. But Pop!_OS is free software and, early on, the company made the decision to make Pop!_OS freely available as a download ISO file so that anyone could install it and use it. It will run on any modern 64-bit hardware. Perhaps within the free software world that sort of “warm fuzzy” feeling of having your own free Linux distribution helps sell hardware? It can’t hurt and, in fact, it generated enough interest in the tech media that FOSSpost named it the Best Linux Distribution of 2022. That put it in pretty good company, as their previous two winners were MX Linux and Linux Mint.


  Once Pop!_OS 22.04 LTS was released on 25 April, 2022, a decision was made to skip the fall “interim” release which would have been 22.10, concentrating on a quantum leap instead of a steady stream of incremental changes. The original COSMIC desktop was working well but a calculation was made that writing a whole new desktop in the Rust programming language would result in something lighter, faster, more responsive, and better overall. There was no deadline to finish it but all new Pop!_OS releases ceased, so that the team could build the new COSMIC DE (desktop environment) as it came to be known. When out, it will include a new text editor, and a lot more. When is it coming? Hard to say, as no date has been announced, but perhaps it will arrive in time to become Pop!_OS 24.04 LTS, due out in April 2024. Meanwhile, hardware is being shipped with a user choice of Pop!_OS 22.04 LTS or Ubuntu 22.04 LTS.
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  Getting Pop!_OS


  Pop!_OS is easy to download from the official website. Downloads are http only, as there are no BitTorrents available. There is a choice of three downloads: the “vanilla” version at 2.48 GB, one that includes built-in Nvidia graphics card support at 2.97 GB, and a Raspberry Pi 4 version at 2.41 GB.


  By today’s standards, these file sizes are fairly small. For example, the “vanilla” version is half the size of Ubuntu 23.04 which is 4.9 GB.


  SHA256 sums are provided for each version, making it easy to run a quick check and make sure the download is good.
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  Installing


  I tested Pop!_OS 22.04 LTS by dropping it onto a USB stick equipped with Ventoy 1.0.91. Pop!_OS is officially listed as “supported” on Ventoy, and it booted up just fine from there. After testing it out, I went ahead and installed it on my laptop from Ventoy, and that ran smoothly too.


  One oddity: when you boot up Pop!_OS from a stick for testing, the installer interface opens and cannot be closed or minimized. If you want to just test out the desktop, the best way is to move to a new workspace and do the testing there, without the clutter of the installer sitting open.
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  System requirements


  The recommended system requirements for Pop!_OS 22.04 LTS are:


  
    	64-bit processor


    	4 GB RAM


    	16 GB of hard-drive space

  


  In my testing, I found after a fresh reboot with nothing open, that Pop!_OS 22.04 LTS idled at 4.2 GB, and with Firefox, gedit, LibreOffice Writer and Nautilus open, it was using 9.5 GB of RAM – so 4 GB is unrealistically low. This compares to an idle RAM of 1.3 GB for Ubuntu 22.04 LTS.


  Hopefully, the idle RAM required will be decreased when the next Pop!_OS version with COSMIC DE is introduced.
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  Trying out Pop!_OS 22.04 LTS


  The COSMIC desktop is very flexible and configurable. You can see a lot of work and testing has gone into it, even though this is only its third release with COSMIC.


  Pop!_OS is basically a modified Gnome desktop with Gnome applications. The menu system is different from what you find in plain Gnome or even in Ubuntu, though. Ubuntu has two menus, while Pop!_OS has three: the launcher, applications, and workspaces. Each can be accessed several ways: via keyboard shortcuts, mouse gestures, or point and click.


  The launcher is just a simple interface where you can search for applications which are currently open or closed. They can then be selected by mouse or keyboard. Using it is fast and easy. It is opened by default by a tap on the super (Windows) key, although , if you want something else, all the key bindings can be changed.


  The applications menu can be opened by super+a from the panel button, or a four-fingered swipe right. The workspaces menu can be opened by super+d from the panel button, or a four-fingered swipe left. A four-finger swipe up or down changes workspaces. Workspaces can be set as fixed in number or dynamic, which means one more is available than you are currently using. There are also default keyboard shortcuts for many common actions. For instance, super+t opens Gnome Terminal, while super+f opens Gnome Files (Nautilus).


  Whether you prefer to point-and-click, stay on the keyboard, or use your mouse or touchpad, Pop!_OS has you covered.


  Pop!_OS also has sophisticated tiling capabilities which arrange open application windows in a non-overlapping manner, plus allow grouping and stacking them. This probably works better on a bigger screen than a laptop.


  There is a definite learning curve, but once you master a few items, work becomes very quick. Overall the COSMIC desktop works very well in this release. It really does feel much more geeky than enterprise oriented.
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  Settings


  Unlike Ubuntu, which offers minimal user settings, Pop!_OS gives users lots of choices. Some distributions, like Lubuntu and Ubuntu Budgie, also have lots of choices, but the settings are all spread out and can be hard to find. This is one area where Pop!_OS shines, as the settings are all in one place, in a modified Gnome settings GUI. It is quite outstanding how organized it is. Not only can users configure the desktop from settings, but also set updates and even connect to help pages and open support tickets, if on System76 hardware.


  At present, the settings are a bit uneven, though. Pop!_OS has its own custom dock, and the setting menus allow dozens of customizations. You can make it look and work almost anyway you want. My personal favorite dock setting is that I can turn it off as I prefer to save the screen real estate and use the launcher instead.


  In contrast to the myriad of dock settings, there are only two window themes: dark and light. The dark theme is basically black, and the light is light colored windows with brown tops.


  Pop!_OS provides 53 wallpapers that run from whimsical, to bright, to toned down, to abstract, all from the pens of the company artists. Quite a number are robot-themed, which seems to be a System76 specialty. There is probably a wallpaper here for everyone, but you can also use your own, if desired.


  The default system font is Fira Sans in either a 10 or 11 pt, which I found a bit small so, as suggested in the excellent on-line documentation, I installed Gnome Tweaks and bumped the fonts up to 12 pt, which looks much better. Gnome Tweaks opens up many additional setting possibilities.


  Overall, the main settings GUI has too many choices to describe in detail, but I will mention two that I found useful – the window buttons and the top panel buttons. By default, Pop!_OS windows show only “minimize” and “close” buttons, but the settings offer adding a maximize button or removing the minimize one. I prefer all three on my windows. There is also a setting to remove the “applications” and “workspaces” buttons from the top panel which I did to reduce clutter, since I prefer using the keyboard shortcuts anyway.


  Applications


  Some of the applications included with Pop!_OS 22.04 LTS, including updates, are:


  
    	Archive Manager (File Roller) 3.42.0 archiver


    	CUPS 2.4.1 printing system


    	Document Viewer (Evince) 42.3 PDF viewer


    	Document Scanner (Simple Scan) 42.0 optical scanner


    	Files (Nautilus) 42.6 file manager


    	Firefox 114.0.2 web browser


    	Gnome Calendar 41.2 desktop calendar


    	Gnome Disks 42.0 disk manager


    	Gnome Terminal 3.44.0 terminal emulator


    	Image Viewer (Eye of Gnome) 42.0 image viewer


    	LibreOffice 7.3.7 office suite


    	MPV 0.34.1 video player


    	PulseAudio 15.99.1 audio controller


    	Popsicle 1.3.0 USB ISO writer


    	Text Editor (gedit) 41.0 text editor


    	Geary 40.0 email client


    	Pop!_Shop 3.4.2 package management system


    	Videos (Totem) 42.0 movie player


    	Wget 1.21.2 command line webpage downloader

  


  As can be seen, these are a mix, mostly from Gnome 40-42. What is more notable than what is here, is what isn’t. Not included are a webcam application, music player, photo manager, bittorrent client, file back-ups, image editor, video editor, remote desktop client, and games, although all are available in the repositories, if you want them.


  LibreOffice is provided complete, lacking only LibreOffice Base, the database application that is rarely used.


  The default suite of applications is enough to get most people started, but is fairly minimal compared to many distributions. Personally, I prefer this approach, as I would rather add the applications I need, than have to identify and remove ones I don’t want, in an effort to reduce clutter.


  Pop!_OS has its own repositories, which are a mirror of the Ubuntu ones. It uses .deb files by default, but FlatPak is enabled, using flathub.org. There are no Snap applications and snapd is not installed by default, although it is in the repositories, if you want it.


  With no Snaps, Firefox is from the Mozilla-provided tarball instead. This does give slower updates to new versions but also avoids all the current list of complaints about the Snap version of Firefox.


  Package management is via the Pop!_Shop, a fork of the elementaryOS software center. Pop!_Shop not only provides graphical installation and removal of packages, but also system updates. Pop!_Shop does offer up proprietary software applications from FlatHub, including the Google Chrome and Opera browsers. Because it is based on Ubuntu, Pop!_OS uses APT, so you can easily do your package management from the command-line or install other package managers like Synaptic.


  Conclusions


  Overall Pop!_OS 22.04 LTS is quite impressive in daily use. Once you learn some of the keyboard shortcuts, it becomes fast and smooth. The level of customization available makes it easy to adapt it to your own way of doing things, rather than the other way around. That quickly makes it feel friendly and familiar.


  It will be very interesting to have a look at the next release of Pop!_OS with the new Rust-based COSMIC DE and see what it brings.


  External links


  Official website: https://pop.system76.com/


  
    Adam Hunt started using Ubuntu in 2007 and has used Lubuntu since 2010. He lives in Ottawa, Ontario, Canada in a house with no Windows.
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  Book Review: Python Playground Second Edition


  Written by Greg Walters
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  Python Playground Second Edition
Geeky Projects for the Curious Programmer 
 by Mahesh Venkitachalam


  Publisher: No Starch Press
 Release date: September 2023
 Pages: 448
 ISBN-13: 9781718503045 
Price: $39.99 USD 
level: intermediate


  I did the original review on Python Playground First Edition back in FCM 105 (January 2016). I rated it 5 stars and said that "this is a book that belongs in every Python programmer’s library". Apparently, No Starch Press liked it so much, it’s now in the advertising for the second edition.


  The second edition does not disappoint! There are 5 new projects that are, as his previous project set, exciting, and provide very good Python background in the real-world. The new projects include features such as an IoT garden monitor, Machine-learning driven speech recognition system on the Raspberry Pi, and using the RPi Pico to emulate the plucking of guitar strings with harmonics.


  I finally got around to trying out the flocking Boids program and I have to say that I could sit and watch this program for well over an hour. It’s that addictive.
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  You can even click in the window to add new Boids and watch them join a flock.


  This is yet another 5 star book, and my comment from the last review of Mr. Venkitachalam’s book still stands! It’s a book that belongs in every Python programmer's library!
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    Greg Walters is a retired programmer living in Central Texas, USA. He has been a programmer since 1982 and in his spare time, he is an author, amateur photographer, luthier, fair musician and a pretty darn good cook. He still is the owner of RainyDaySolutions a consulting company and he spends most of his time writing articles for FCM and tutorials. His website is www.thedesignatedgeek.xyz
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  Letters


  Compiled by Ronnie Tucker


  
    If you would like to submit a letter for publication, compliment or complaint, please email it to: letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.
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  Q&A


  Compiled by Erik The Unready




  
    If you have a Linux question, email it to: misc@fullcirclemagazine.org, and Erik will answer them in a future issue. Please include as much information as you can about your query.
  


  
    Welcome back to another edition of Questions and Answers! In this section, we will endeavour to answer your Ubuntu questions. Be sure to add details of the version of your operating system and your hardware. I will try to remove any personally identifiable strings from questions, but it is best not to include things like serial numbers, UUIDs or IP addresses. If your question does not appear immediately, it is just because there is such a lot and I do them ‘first-come-first-served’.
  


  Recently I had a full stack developer log a ticket for Chrome on Ubuntu 22.04 spaz-ing out with “connection not private” and “cert authority invalid”. I had the guy update his machine and try another browser, Brave. Brave worked at first and then also turned to mush. We would remove the browser, purge anything related to it and re-install and it would work. Then fifteen minutes later, I would get an image of the “error” and we would be back to square one. This continued and of course the website with the error is Gitlab, so we know it is not the website. This is now cyclical and a clean up results a working browser for fifteen to twenty minutes, then the issue is back. I was not convinced it was a machine issue, but also could not pinpoint why the browser would go out of whack in a short period of time. At first I was busy, so we did it over instant messaging, but later when we both were free, we did a desktop sharing session. And when I leave the session all is well, just to get the message twenty minutes later saying it is doing the same. I was now convinced the user was doing something, but I could not say what. This time, instead of ending the call, I opted to stay on for 20 minutes. Lo and behold in about 15 minutes, the user opens up a tab, goes to some really sketchy address and the screen fills with ads and popups and whatnot. I stop him right there and get him to install ublock origin. We clear his browsers cache & history etc. I ask him to visit that site again. This time ublock immediately pops up saying the site is trying to inject code etc. If you have to watch some sports and you do not have paid services television, go to your local sports betting site and watch it there, you will be better off. Most of these places have legal streams you can watch to make your bets. If a site address seems dodgy, it probably is dodgy. Beware of sites that try to disable your mouse right click and copy.


  


  
    	Q I have a Kubuntu 23.04 install and I have been trying different DE’s as my ‘puter is rather old, just to get a feel of things and see how much snappier it can be. I decided to stick with KDE, but now my night light is not working any more and I do most of my work at night. Google says it is Nvidia drivers, but this in Intel 945? I would like some input here.


    	A Honestly, I’d just install redshift or reinstall fresh, as tacking on desktops is not something I’d recommend. As for older hardware and lighter desktops, maybe have a look at Bodhi Linux, if you want to stick with the Ubuntu base.


    	Q I can’t upgrade from ubuntu 23.04 to 23.10. No matter what I try, it does not want to. I have followed the same tutorials I used to update to 23.04, but it look like they are no longer valid?


    	A Whoa tiger!!! Reign in those horses!! The clue is in the name, Ubuntu 23.10 – the 10 being the tenth month, and since it is only the ninth month at the moment....


    	Q My laptop has a very slim bezel and a touch screen. My issue is that if I adjust the screen, I cannot help but touch the glass and the mouse pointer clicks there. I have tried turning it off via the config file, as per the internet, but it is hit-and-miss, as when it comes out of sleep, it does not read the config file again, and it is back on. A reboot will solve this, but what is the point?


    	A Enter your computer’s BIOS / UEFI and turn it off there.


    	Q I have Ubuntu 23.04 with Virtualbox and FerenOS in the VM. I also have Ubuntu 23.10 beta in the VM. The issue I have is that if I leave it for a while, FerenOS goes to “sleep” with a black screen, and no amount of keyboard or mouse jiggling will wake it up. This is not the case with Ubuntu 23.10. The only way it wakes up, is if I send it the shutdown signal, which does not shut it down.


    	A That is going to be one for the folks at the FerenOS boards. Whist it is based on Ubuntu, it is not an official flavour.


    	Q What means this: “Stderr: VBoxManage: error: VT-x is not available (VERR_VMX_NO_VMX)”


    	A That means your setup does not support virtual extensions. You did not tell us what machine or OS you are using. Another option may be that it is turned off in your BIOS settings, if your machine does indeed support virtual extensions.


    	Q I’m trying to write an in-house auditing program, but I’m learning still and while I’m sure this is the correct command I used in Ubuntu 14.04, something seems to have changed, and I’m not sure what. If I just run the command I can see the following: brendan@giblets1:~$ dmidecode system-serial-number /sys/firmware/dmi/tables/smbios_entry_point: Permission denied /dev/mem: Permission denied


    	A Sudo... Happens to the best of us.


    	Q How come the version of a snap package is still behind the official latest version of the app? I thought snap is supposed to keep everything latest?


    	A Snap packages are created separately from an application’s release and they may not be made by the application’s developer, but rather an enthusiast who uses the application themselves. Snap does not equal official.


    	Q I have been learning Docker & Vagrant on my Ubuntu 22 laptop. I ran a docker image and I have lots of them. Does this affect anything? I did run sudo apt autoremove, but it made no difference.


    	A Sudo apt autoremove is for your system files and does not affect programs and their caches. You are on the right track though. The docker version is prune: docker image prune


    	Q I am wondering what the issue could be, I can connect to my machines via RDP, but if I disconnect for too long, I cannot connect again, and it is frustrating. I only use LTS and all machines are up to date.


    	A Install caffeine and caffeine indicator on the machines and activate them. Repeat your test and get back to us.


    	Q How can I install a pecific version of any app in the Snap store? If I go to discord, it only shows latest/stable latest/edge


    	A As far as I know, you cannot. You could do that with AppImages though and I’m not sure about Flatpaks.


    	Q Is there a way to get Clion cheaper on Ubuntu? My 30 days are up and I don’t have that kind of money.


    	A You can google around for a community edition or you can use something else, like code::blocks.


    	Q How come I keep seeing this ~~~ Reading package lists... E: The repository 'http://security.ubuntu.com/ubuntu kinetic-security Release' does not have a Release file. E: The repository 'http://archive.ubuntu.com/ubuntu kinetic Release' does not have a Release file. ~~~~ I just goes on and on. Someone said I should choose the UK mirror, but I don’t know how to do that.


    	A That won’t help either, it is because Ubuntu 22.10 has reached EOL already. Install a LTS release if you plan on keeping the install.


    	Q With flagship Ubuntu 22.04 installed, I can dim my display to the minimum, which is great for evenings. I prefer XFCE though, so in Xubuntu, instead of going to the dimmest, it turns the screen off and I cannot turn it back on again, I have to reboot. How do I fix this?


    	A It’s probably a bug. File a bug report with as much info as you can.

  


  
    Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he's done it.
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  Tabletop Ubuntu:


  Written by Josh Hertel


  Back next month


  
    Josh Hertel is a husband, father, mathematics educator, tabletop gamer, techie, and geek. https://twitter.com/herteljt
  


  


  
    [image: Contents]
  


  Ubuntu Games: Moonstone Island


  Written by Erik


  Website: https://rawfury.com/games/moonstone-island/


  Price: About $10 USD


  Blurb: “Moonstone Island is a creature-collecting life-sim set in an open world with 100 islands to explore. Make friends, brew potions, collect Spirits, and test your strength in card-based encounters to complete your Alchemy training!“


  The game has Stardew valley vibes, and what I mean by this is that the game starts out like a farming sim. You wake up, you manage your crops and all the stuff that goes with it. You can upgrade your house, your greenhouse, etc, etc. You can also befriend NPCs, even get romantic with some – if you want to. Enter the pokemon creature collector. The twist is… you get to use certain crops to tame spirits to fight for you in card based battles (the Alchemy part). Enter the card battler. There is also a slight twist here, where certain spirits get certain cards, or should I say, different card pools. This entices you to get other spirits to access other card pools… quite clever. The spirits themselves are rather silly, much like pokemon and then some. There is also the case for the one hundred islands mentioned above; they are procedurally generated and randomly placed, so you will need to explore them too, as resources are scattered among the islands. This is especially true for moonstones – which are very limited per island. If I do not have it wrong, it is one per island. You also need to find new plants to plant, with which to capture the spirits, and these are also usually on another island. (I’m sorry Mario, the princess is in another castle.) You also need to grow, or level up, by finding “power-ups”. As you adventure, you also need to unravel the mystery of the “dark” spirits (the story). There are dungeons scattered around the map that I strongly suggest you complete. You may even be lucky enough to find a moonstone in one of the chests, or some new recipes. Did I mention you can upgrade your spirits?


  
    [image: game2]
  


  You are not confined to the starting island; if you are willing to put some effort in, you can have more farms on other islands. Or… You can Baba Yaga it, and carry a magic house with you, cauldron and all. (Your camp away from camping, you will see what I mean.) Exploring will net you treasure maps that enhance the exploring experience.
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  All the aspects of the game seem well balanced, with no task taking up all your time. I will be upfront and say creature collecting and card battlers are my least favorite game genres; however the farming, coupled with the exploration, makes the game feel fun. You can explore and farm and have a chill experience if you prefer casual, but there is also a lot of content, should you pursue the main quest and all the side quests. Befriending the NPCs also has more options than other similar games. You don’t simply give gifts to be liked, you can also go on dates with NPCs. The dialogue is also better than average, especially when romancing (some options will make you chuckle under your breath). The game does have the pronoun cancer, so you have been warned. Maybe I should have mentioned that in the beginning, and maybe the steam tag should have read LGHDTV+ or whatever. If you want to steer clear of any woke nonsense, maybe do not buy this game. Date locations are also not all the same; you can choose from places like the beach to exotic locations like hot springs, and more. To stay “hip and happening”, the developers / artists equip your dates with nose rings, making them look like cows though, otherwise the portraits are also very good. This is the only area of the game I’d say needs work – more interactions and dialogue options – to get you more invested into the NPCs. Don’t get me wrong, the characters are written very likable and you feel you need more.


  My other criticism is that the sprites feel 8-bit (they are not). It may be a conscious design decision, but I think it looks ugly in an otherwise polished world. I feel that one up, say 16-bit, (smaller pixels), could have made this game stand out graphically too. It is an ambitious project that comes together nicely… but nothing really stands out.
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  Usually with a sim game there is something that you really, really like to continue grinding. Otherwise the fun dies to repetitiveness. As I mentioned before, the farming and exploration is offset against the creature collector and card battler, and I think the creature collector and card battler is weak enough to bring down the pluses of the other two. (I may not like the genre, but I know what makes a good one.) I will tell you why. Deck builders need rare and unique cards, to keep you reaching for more. Each spirit has its own type of deck, but there are no special cards that would slot into any deck or make your creature unique. I had trouble trying to figure out why I would keep / need some of the spirits as they are the same as the next, or do not do anything really useful. Dungeons are copypasta stamped out, with no real variety, a crying shame. One thing I did not talk about is the skills tree, as we are all familiar with them. Skills should carry throughout the game, but some assist only in the beginning and are useless afterwards. I feel consistency is lacking.


  On the plus side, the game is colorful, and the animations look good. The card battler gets better over time and can be really fun (other than what I have mentioned before), and it is very reasonably priced for a new (2023) game.


  If you feel you want to get this game, it is available for Linux via Steam.


  
    Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he's done it.
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  Patrons and Donors
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  The current site was created thanks to Lucas Westermann (Mr. Command & Conquer) who took on the task of completely rebuilding the site, and scripts, from scratch, in his own time. The Patreon page is to help pay the domain and hosting fees. The yearly target was quickly reached thanks to those listed on this page. The money also helps with the new mailing list that I set up.


  Several people have asked for a PayPal (single donation) option, so I ’ve added a button to the right side of the website.


  A big thank you to all those who’ve used Patreon and the PayPal button. It’s a HUGE help.
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  https://www.patreon.com/fullcirclemagazine
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  https://paypal.me/ronnietucker
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  https://donorbox.org/recurring-monthly-donation


  


  Monthly Patrons


  Alex Crabtree
Alex Popescu
Bill Berninghausen
Brian Bogdan
CBinMV
Darren
Dennis Mack
Devin McPherson
Doug Bruce
Elizabeth K. Joseph
Eric Meddleton
George Smith
Henry D Mills
Hugo Sutherland
Jack
Joao Cantinho Lopes
John Andrews
John Malon
John Prigge
JT
Kevin O'Brien
Lee Allen
Leo Paesen
Linda P
Mark Shuttleworth
Norman Phillips
Oscar Rivera
Paul Anderson
Paul Readovin
Rob Fitzgerald
Roy Milner
Scott Mack
Sony Varghese
Tom Bell
Tony
Vincent Jobard
Volker Bradley
William von Hagen



  Single Donations


  2023:


  Floyd Smith
Richard Almeida
Gavin Thompson
Raymond Mccarthy
Michael Grugel
Linda Prinsen
Thomas A Lawell
Ronald Le Blanc
Ronald Eike
Kenneth Martin
Lance Jacob
Roberto Machorro Mejia
Paul Radovan
Christopher LaSota
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  How to Contribute


  
    FULL CIRCLE NEEDS YOU! 

    A magazine isn’t a magazine without articles and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org


    We are always looking for new articles to include in Full Circle. For help and advice please see the Official Full Circle Style Guide : http://bit.ly/fcmwriting
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            FCM #199 Deadline: Sunday 12th November 2023. Release: Friday 24th November 2023.
          
        

      
    

  


  
    	Send your comments or Linux experiences to: letters@fullcirclemagazine.org


    	Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org


    	Questions for Q&A should go to: questions@fullcirclemagazine.org Desktop screens should be emailed to: misc@fullcirclemagazine.org


    	… or you can visit our site via: fullcirclemagazine.org

  


  
    Full Circle Team 

    Editor - Ronnie Tucker - ronnie@fullcirclemagazine.org


    Webmaster - Lucas Westermann - admin@fullcirclemagazine.org


    Editing & Proofreading: Mike Kennedy, Lucas Westermann, Gord Campbell, Robert Orsino, Josh Hertel, Bert Jerred, Jim Dyer and Emily Gonyer


    Our thanks go out to Canonical, to the many translation teams around the world, and to Thorsten Wilms for the FCM logo.

  


  Getting Full Circle Magazine:
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          EPUB Format - Most editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org
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          Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.
        
      

    
  


  


  For the Full Circle Weekly News:
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          You can keep up to date with the Weekly News using the RSS feed: http://fullcirclemagazine.org/feed/podcast
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          Or, if you’re out and about, you can get the Weekly News via Stitcher Radio (Android/iOS/web): http://www.stitcher.com/s?fid=85347&refid=stpr
        
      


      
        	
          
            [image: news2]
          

        

        	
          and via TuneIn at: http://tunein.com/radio/Full-Circle-Weekly-News-p855064/
        
      

    
  


  


  
    FCM PATREON : https://www.patreon.com/fullcirclemagazine
  


  


  
    [image: Contents]
  

OEBPS/Images/game5.png
whouldd you like ko k

thiar






OEBPS/Images/python1.png
Times, Fri, Mar 01,

2019 - Zhougin Burnikel / Will Shortz

00:20

0
ta2 23 24 23
uflT |
t2 e—1—27 20 29
P|I | |
30 31 32 33
Hc |
34 3s 36
L ] ] H
ts7—fss—t30 10 a1 s2—ta3
L u
fas as a6 a1
] LIl
tae m 50—t 1 52
] ]
53 54 ss s6
] ]
s7 se ss
u
teo 61
L
to2 o3
L

15 ACROSS: Sole mate?





OEBPS/Images/donobox.png
EI donorbox





OEBPS/Images/ink3.png





OEBPS/Images/kilobyte.jpg
KILOBYTL
M A G A ZINE

Kilobyte Magazine is a fanzine for 8bit enthusiasts. It covers consoles,
computers, handhelds and more, as well as new games for old systems. If you
grew up with Commodore, Atari, Sinclair or Amstrad, this magazine is for you.

= .
= F

https://retro.wtf/kilobytemagazine/






OEBPS/Images/op1.png
Install -

Installation type

This computer currently has Windows Boot Manager on it. What would you like to do?

Install Linux Mint alongside Windows Boot Manager
Documents, music, and other persona fles will be kept. You can choose which operating system you want each time the computer sarts up.

Erase disk and install Linux Mint
Warning: This willdelete all your programs, documents, photos, music, and any other files in al operating systems.

features..  Noneselected

Advance:

Something else
You can create of resize partitions yoursel, or choose muliple partitions for Linux Mint.

Quit Back Install Now






OEBPS/Images/Pop__OS_22.04_LTS_Nautilus_with_light_theme.jpg
a






OEBPS/Images/game3.png





OEBPS/Images/get3.png





OEBPS/Images/mp3.png





OEBPS/Images/stable1.jpg
W RRDORZICEAIRROCT

<loussitee Blaoausctlle ..

il ==
CILRRE ™

VIO MALLCIG (ONOO T
REHPEACALIRL L 1N FIEENOY

PREIRE (EAVMCINCLY
FBEN KICELERTTON

Honnliculoc
conto

Hiphian

B tunccatis
RanscsLom e






OEBPS/Images/news2.png
=<-tunein





OEBPS/Images/ink10.png





OEBPS/Images/ink5.png
Leek at the gyphs’
_ with ceunters! _





OEBPS/Images/sound.png
<)





OEBPS/Images/Pop__OS_22.04_LTS_Nautilus_with_dark_theme.jpg





OEBPS/Images/phone.png





OEBPS/Images/Pop__OS_22.04_LTS_Settings_manager.jpg





OEBPS/Images/Pop__OS_22.04_LTS_default_dark_desktop.jpg
¥XBEORCOME O





OEBPS/Images/Ubuntu_Budgie_23.04_default_desktop.jpg
Sunday May

Déaw|on






OEBPS/Images/Pop__OS_22.04_LTS_clean_desktop_with_dock_and_buttons_off.jpg
EOSHTEN





OEBPS/Images/comic410.png





OEBPS/Images/Ubuntu_Budgie_23.04_icon_menu.jpg
1788

Sunday May.





OEBPS/Images/ink8.png





OEBPS/Images/Pop__OS_22.04_LTS_applications_menu.jpg





OEBPS/Images/cc1.png
Provides the configuration file context in which the HTTP server directives are specified.

Syntax: if_modified_since off | exact | before;
Default: if modified since exact;
Context: http, server, location

This directive appeared in version 0.7.24.





OEBPS/Images/vbox.png
THE

VIRTUALBOX

NETWORKING PRIMER

Connecting and Configuring
Virtual Machines

Robin Catling






OEBPS/Images/fcm198index.cite.png
fem198index.tex X ChineseSesameBuns.tex X

- \section{Chinese Sesame Buns} =
Chinese Sesame Buns are served as a side
dish. Chinese Sesame Buns get their taste
from all purpose flour mixed with salad oil
and sesame seeds. This Chinese Sesame Bun
recipe is inspired by many restaurants across
the world. \cite{Foo}

- \section*{Ingredients}

- \begin{itemize}
\item All-purpose flour 25\frac{1}{4}s~ Cup
(36 ths) (unsifted)
\item Salt $\frac{1}{4}s-teaspoon
\iten Water 1 Cup (16 Tbsp)

\item Galad nil 3 Tahlocnann
Line: 1 Column: 0 INSERT g

Log Preview Search Results x

ssages

B Ad &> Kk e[33of34> 4 @W[]=

Bibliography






OEBPS/Images/stable4.jpg
Style Selector for
SDXL 1.0

prompting, installed
sd-webui-oldsix-
prompt

prompting

Custom Hires Fix
script, manipulations

Refiner
script, manipulations

seamless-tile-
inpainting
script

FaceswapLab
editing,
manipulations

Dynamic Javascript
prompting

prompts filter
script

a Automaticl111 Extension allows users to select and apply different styles to
their inputs using SDXL 1.0.
Update: 2023-09-26 Added: 2023-07-30 Created: 2023-07-27 stars: 205

Prompt library - comes with built-in Chinese libeary
Update: 2023-09-19 Added: 2023-07-30 Created: 2023-07-27 stars: 839

Adds custom hires fix with advanced features to improve details.
Update: 2023-08-31 Added: 2023-07-30 Created: 2023-02-01 stars: 27

Adds support for SD XL refiner models, it's extending the pipeline to process
the last steps with the refiner models Unet.
Update: 2023-08-12 Added: 2023-07-30 Created: 2023-07-28 stars: 148

Ascriptfor making tiles seamless using inpainting. Designed for SD1.5
inpainting model at 512x512, but should work fine with other inpainting
models.

Update: 2023-07-29 Added: 2023-07-27 Created: 2023-07-21 stars: 16

Extended faceswap with multiple faceswaps, inpainting, checkpoints.
Update: 2023-09-10 Added: 2023-07-27 Created: 2023-07-24 stars: 313

Embed Javascript code blocks in positive and negative prompts.
Update: 2023-08-21 Added: 2023-07-22 Created: 2023-07-21 stars: 15

Filter out banned words in prompts and negative_prompts, and also filter out
duplicate prompts and empty prompts.
Update: 2023-08-02 Added: 2023-07-20 Created: 2023-07-19 stars: 7

Installed

Install

Install

Install

Install

Install

Install

Install





OEBPS/Images/stable6.jpg
NIRRT MIGHAGOSA YO A GO M LIN K9

o e

e

FJCRACE NS e |

SNEIF KUF. ST TVES EOWIN
[ZIILEAE ACYORDCO TREFS TEENTT
& e
,

ATEMKCTAIHORIS
POOT DBIGIAESE

*AEENTIT
VO QLSN EIG

NHUN ESEHUNEISK

Pt oo
e Cisonoohoos

IULLL

5 0CE HCHTIAEE ESGHERE~
OASIA LLEEA

NRUBHELR
YFEVN EERDESION

Nescoubsidapanseocm s
Pl eutese soneabwos

Tesiitrees e fenw

THRE
COITRIE]

SIAVECTONNY, -
NUTTH (Ghix I NSYe VIS IS IAES

16 EDGRILAD.





OEBPS/Images/licence.png





OEBPS/Images/paypal.png
g

visa H e





OEBPS/Images/ink1.png





OEBPS/Images/Pop__OS_22.04_LTS_workspaces_menu.jpg





OEBPS/Images/fcm198index.bib.png
File Edit Search View Document Help

pbook{TLC,
author = "Mittelbach, Frank and Fischer,
title = "The Latex Companion",
year = "2023",
language = "English”,
edition = "3",
volumes = "2",
publisher = "Addison-Wesley",
location = "New York",
isbn = "978-0-13-816648-9",

}
@book{Foo,
author = "Foo, Susanna”,
title = "Chinese Cuisine",
year = "1995",
language = "English”,
publisher = "Chapters Publishing”,
"shelburne, VT",
-881527-94-8",
pages = "352",
}
@book{Liang,

author = "Liang, Lucille",

title = "Chinese Regional Cooking",
year = "2002",

language = "English",

ulrike",






OEBPS/Images/get1.png





OEBPS/Images/shells.png
@ shells.com

Linhx on Your iPad

For as low as $4.95, you can have your own personal Linux cloud computer in minutes on any device.






OEBPS/Images/micro1.png
MicroPython v1.21.0 on 2023-10-06; Raspberry Pi Pico W with RP2040

Type "help()" for more information.
>5>





OEBPS/Images/Ubuntu_Budgie_23.04_defauilt_Pocillo-dark_theme.jpg
1™

Sunday May






OEBPS/Images/Ubuntu_Budgie_23.04_Pocillo-light_theme.jpg
sEEEYmE





OEBPS/Images/Pop__OS_22.04_LTS_alternate_COSMIC_wallpaper.jpg
SO HEN

BEEORoMGEOE





OEBPS/Images/podcast.png





OEBPS/Images/ink4.png





OEBPS/Images/news3.png





OEBPS/Images/ink6.png
Look at the gyphs’
_ With counters!





OEBPS/Images/Ubuntu_Budgie_23.04_with_Firefox.jpg
fulcie Mot News ot Srer  SpecalEdtos Tl Gt

Full Circle

= :

Full Circle’

SN
Y
==

{nkscapespecial it Freeca0 special Eion

Full Circle






OEBPS/Images/game2.png





OEBPS/Images/fcm198index.style.png
fem198index.tex X BQA8 & DIk «[33of34> 4 G

\include{sauces} &
\include{simpledipsauce}

\backmatter

% bibliography, glossary and index will go

here

\include{glossary} Bibliography

\bibliographystyle{alpha}
\bibliography{fcn198index}

(Dun1s) Fuckta Do, The Fod o

\printindex St Foo. Chinse Cuin. Chaptrs Pblising, 196,
\end{document} Dl T o, Cincse el osking, Chtl ook 1970
2 Ll Liang, Chincse Rinal Coking. Scling, 2 edtion, 202
Tpd @R INSERT Frask Mitlbach and Uk Fiher, The Lotes Compaiors

ddbon-Woske, 3 achtion, 223

ssages | Log  Preview  Search Results






OEBPS/Images/book1.png
o

Figure 1

600

500

400

359. y=256.

x=

bl

Aaed $Q





OEBPS/Images/Ubuntu_Budgie_23.04_list_menu.jpg
Sunday May.

ces@meEUD






OEBPS/Images/news1.png





OEBPS/Images/ink11.png





OEBPS/Images/exclaim.png





OEBPS/Images/stable2.jpg
Easy Diffusion w.s

PN Generate By Help & C:

Enter Prompt @ or Load from a fls + image Modifiers| '+ Embedding

 a photograph of an astronaut riding a horse|

Neg:

Prompt @ (optional)
Initial Image (img2img) (optional) @
& Browse # Draw

Image Settings /

Note: The Image Modifiers section has moved to the + Image Modifiers button at the
top, just above the Prompt textbo.

ergemodels  #

Type a prompt and press the "Make Im
You can set an “Initial Image” if you w

You can also add modifiers like "Realis
“Image Modifiers" section and selectin

Click "Image Settings" for additional se

Enjoy! 2)





OEBPS/Images/patreon.png
(® patfreon





OEBPS/Images/ink12.png





OEBPS/Images/Pop__OS_22.04_LTS_default_light_desktop.jpg





OEBPS/Images/cc2.png
Syntax: merge_slashes on | off;
Default: merge slashes on;
Context: http, server





OEBPS/Images/198cover.jpg
® Full Circle

ssssssssssssssssssss

BOOK REVIEW

7 Ubuntu Budgle & Pop! OS

VIEWS






OEBPS/Images/return.png
RETURN TO CONTENTS






OEBPS/Images/book2.jpg
jzacoxpmormcn )
PYTHON
PLAYGROUND






OEBPS/Images/NoStarch_advert.jpg
Tech Books Made Better

PYTHON
CRASH COURSE

DEAD SIMPLE
PYTHON

—
PRACTICAL

Python Crah Course,
3rd Edition
9781718502703
$4499PB | 552 pages

DEVOPS FoR

(]
How Linux Works,
3rd Edition
9781718502024 781718500921 9781718500402
$33.99 8| 328 pages $59.99 B 752 pages $49.99 B | 464 pages
HE RUS' DaTA sTRUCTURES DEEP
PROGRAMMING THE FON WAY LEARRING

CANGUAGE

Forensics
9781718501966
559.99 7B 400 pages.

D e,
DevOps for the.
Desperate
o7817I8502482
52999 176 pagy

pessl
\ EBEEANC
The RustProgramming
ekt
Srassisios

$h5597 | 540 poges

Data Structures Deop Leaming
the Fun Way.

9781718502604 9781718500723
§39.99 B | 304 pages $99.99PB | 776 pages

Codebrealing

o781718502727
§29.99 P8 488 pages

Get 25% off your order at nostarch.com with code FULLCIRCLE25





OEBPS/Images/stable3.jpg
Stable Difiusion checkpoint
san bse Lossteumsons lesscank. + [

biimg  imgAmg  Ers  PNGInfo  Checkpoin

Settngs Etensions.

Iostalled  Avalable  insalfom URL Backup/Restore

Disableallextensions
Check for updates losios

Time taken: 08 sec.
65768 R 63268 5y 15311564368 (972%)

8 Exmion e Bnch verdon  ome from
@ syescecon. [ ————— mon essaoh | Sun AT 181990202) [ newcommts
3 sl o wens mages st comAkeshsabe ifuin vebutmages rowsecgt man  fsesgd | Mon Sep 11 25551202 et

@ us wutin None Wedsep 1 w02

G baein Nove Wessep 1 20012023

@ s bt Wone Weasep 1 2w 02

@ sk st None Wessep 1 240032023

& cavas oom andan butein one Wedsepr 2o 2

8 s optonssecon buttin Wone Wesseo T 2022

@ ot butein Hone Wedsep 212200032023

B omrndercncer bt None Wessep 1 201202

APl - Gthb - Grdo + Sartupprofie - Relosdul
Virion VLS« pyAORALLA - ok 20Locul + Sormarcih » GRAGAILY + checkpoNt TIATSRK





OEBPS/Images/star.png





OEBPS/Images/Ubuntu_Budgie_23.04_alternate_wallpaper.jpg





OEBPS/Images/paetron.png





OEBPS/Images/comic412.png
The Daily Waddle

ACTUALLY “THROW ME A BONE”
MEANS HELP ME OUIT...





OEBPS/Images/ink9.png





OEBPS/Images/Pop__OS_22.04_LTS_alternate_System76_wallpaper.jpg
W \ \&J \ —.1
ﬂg\ Ud\L i

)
REomMR3O@






OEBPS/Images/op2.png
GNU GRUB Version 2.06

Advanced options for Linux Mint 21 Cinnamon
Windows Boot Manager (on /dev/sdal)
UEFI Firmware Settings

Use the | and | keys to select which entry is highlighted.

Press enter to boot the select 0S, ‘e’ to edit the commands

before booting or ‘c’ for a command-line.






OEBPS/Images/qr.png





OEBPS/Images/stable5.jpg
SDXL Styles

(@ Enable Style Selector /

Randomize Style
Every promptin Batch il Have R
Randomize For Each Iteration

G P A Kl i ;

@ Generate Al tyles n Order

Style
30 Model Abstract Advertising Alien Analog Film Anime Architectural
Cinematic Coliage Comic Book Cratt Clay Cubist Digital Art Disco
Dreamscape Dystopian Enhance Fairy Tale Fantasy At Fighting Game
Film Noir Flat Papercut Food Photography GTA Gothic Grafftl Grunge
HOR Horror Hyperrealism Impressionist Isometric Style Kirigami

egend of Zelda Line At Long Exposure. Lowpoly Minecraft Minimalist

Monochrome Nautical Neon Noir Neon Punk Origami Paper Mache
Paper Quilling Papercut Collage Papercut Shadow Box Photographic Pixel Art
Pointilism Pokémon PopArt Psychedelic RPG Fantasy Game Real Estate
Renaissance Retro Arcade Retro Game Silhovette Space Stacked Papercut
Stained Glass Steampunk Strategy Game Street Fighter Super Mario Surrealist
Techwear Fashion Texture Thick Layered Papercut Tiltshife Tribal Typography
Watercolor Zentangle @ base

Script

None





OEBPS/Images/ink2.png





OEBPS/Images/new-distrowatch-banner-transparent.png
istroWatel¥eom

Put the fun back into computing.






